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xix
 Introduction
 Welcome to Adobe Photoshop CC on Demand, a visual quickreference book that shows you how to work efficiently withPhotoshop. This book provides complete coverage of basic toadvanced Photoshop skills.
 How This Book WorksYou don’t have to read this book in any particular order.We’ve designed the book so that you can jump in, get theinformation you need, and jump out. However, the book doesfollow a logical progression from simple tasks to more com-plex ones. Each task is presented on no more than two facingpages, which lets you focus on a single task without havingto turn the page. To find the information that you need, justlook up the task in the table of contents or index, and turn tothe page listed. Read the task introduction, follow the step-by-step instructions in the left column along with screen illus-trations in the right column, and you’re done.
 What’s NewIf you’re searching for what’s new in Photoshop CC, just lookfor the icon: New!. The new icon appears in the table of contents and throughout this book so you can quickly andeasily identify a new or improved feature in Photoshop. Acomplete description of each new feature appears in the NewFeatures guide in the back of this book.
 Keyboard ShortcutsMost menu commands have a keyboard equivalent, such asCtrl+P (Win) or A+P (Mac), as a quicker alternative to usingthe mouse. A complete list of keyboard shortcuts is availableon the web at www.perspection.com.
 How You’ll Learn
 How This Book Works
 What’s New
 Keyboard Shortcuts
 Step-by-Step Instructions
 Real World Examples
 Workshops
 Adobe Certification
 Get More on the Web
 http://www.perspection.com
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xx
 Step-by-StepInstructionsThis book provides concise step-by-step instructions that show you“how” to accomplish a task. Eachset of instructions includes illus-trations that directly correspond tothe easy-to-read steps. Alsoincluded in the text are time-savers, tables, and sidebars tohelp you work more efficiently orto teach you more in-depth infor-mation. A “Did You Know?” pro-vides tips and techniques to helpyou work smarter, while a “SeeAlso” leads you to other parts ofthe book containing related infor-mation about the task.
 Real World ExamplesThis book uses real world exam-ples files to give you a context inwhich to use the task. By usingthe example files, you won’t wastetime looking for or creating sam-ple files. You get a start file and aresult file, so you can compareyour work. Not every topic needsan example file, such as changingoptions, so we provide a completelist of the example files usedthrough out the book. The exam-ple files that you need for projecttasks along with a complete filelist are available on the web atwww.queondemand.com orwww.perspection.com.
 Real worldexamples helpyou apply whatyou’ve learnedto other tasks.
 Illustrationsmatch thenumberedsteps.
 Numberedsteps guideyou througheach task.
 Did You Know? alertsyou to tips, techniquesand related information.
 See Also points you torelated information inthe book.
 Easy-to-followintroductionsfocus on asingle concept.
 http://www.queondemand.com
 http://www.perspection.com
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Introduction xxi
 WorkshopsThis book shows you how to puttogether the individual step-by-step tasks into in-depth projectswith the Workshop. You start eachproject with a sample file, workthrough the steps, and then com-pare your results with projectresults file at the end. The Work-shop projects and associated filesare available on the web atwww.queondemand.com orwww.perspection.com.
 Adobe CertificationThis book prepares you for theAdobe Certified Expert (ACE) andAdobe Certified Associate (ACA)exams for Adobe Photoshop CC.Each Adobe certification exam hasa set of objectives, which areorganized into broader skill sets.To prepare for a certificationexam, you should review and per-form each task identified with anACE or ACA objective to confirmthat you can meet the require-ments for the exam. Informationabout the ACE and ACA programsare available in the back of thisbook. The ACE and ACA objectivesand the specific pages that coverthem are available on the web atwww.queondemand.com orwww.perspection.com.
 The Workshopswalk you throughin-depth projectsto help you putPhotoshop towork.
 http://www.queondemand.com
 http://www.perspection.com
 http://www.queondemand.com
 http://www.perspection.com
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xxii
 Get More on the WebIn addition to the information inthis book, you can also get moreinformation on the web to helpyou get up to speed faster withPhotoshop CC. Some of the infor-mation includes:
 Transition Helpers◆ Only New Features.
 Download and print the newfeature tasks as a quick andeasy guide.
 Productivity Tools◆ Keyboard Shortcuts.
 Download a list of keyboardshortcuts to learn faster waysto get the job done.
 More Content◆ Photographs. Download
 photographs and othergraphics to use in yourPhotoshop documents.
 ◆ More Content. Downloadnew content developed afterpublication.
 You can access these additionalresources on the web atwww.perspection.com.
 Additionalcontent is availableon the web.
 http://www.perspection.com
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Customizing the Way You Work
 Introduction
 No description of Adobe Photoshop would be complete with-out that well-known, but little utilized area called Preferences.Photoshop preferences serve several purposes. They helpcustomize the program to your particular designing style, andthey help you utilize available computer resources toincrease the overall performance of the program.
 By modifying File Handling preferences, such as append-ing a file extension on the file, or being asked when saving alayered TIFF file, you can streamline the file saving process.In addition, you can change the way your cursors look. Forexample, do you want your paintbrush to look like a paint-brush when you paint, do you prefer a precision crosshair orthe actual brush size shape, or the shape with a crosshair?
 As you use Photoshop, you'll come to realize the impor-tance of working with units and rulers. Precision is the nameof the game when you are working with images. What aboutthe color of your guides, grids, and slices? No big deal, yousay. Well, if you've ever tried viewing a blue guide against ablue-sky image, you know exactly why guide color is impor-tant. By working through preferences such as Image Cache,Scratch Disks, and RAM (Random Access Memory), speedincreases of up to 20% can be achieved.
 In addition, customizing the program helps make youmore comfortable, and studies show that the more comfort-able you are as a designer, the better your designs. Plus,being comfortable allows you to work faster, and that meansyou'll accomplish more in the same amount of time. Whatdoes setting up preferences do for you? They makePhotoshop run faster (up to 20%), you work more efficiently,and your designs are better. That's a pretty good combina-tion. Photoshop doesn't give you Preferences to confuse you,but to give you choices, and those choices give you control.
 3
 3What You’ll Do
 Optimize Photoshop
 Set General Preferences
 Set File Handling Preferences
 Set Interface Preferences
 Change Sync Settings Preferences
 Set Cursors Preferences
 Control Transparency & GamutPreferences
 Change Units & Rulers Preferences
 Change Guides, Grid & SlicesPreferences
 Set Plug-Ins Preferences
 Select Scratch Disks
 Allocate Memory & Image Cache
 Set Type Preferences
 Manage Libraries with the Preset Manager
 Use and Customize Workspaces
 Build Specialized Workspaces
 Create a Customized User Interface
 Define Shortcut Keys
 55
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56 Chapter 3
 Optimizing Photoshop
 Photoshop is a powerful program, and assuch, requires a tremendous amount of com-puting power. When working on large docu-ments, a poorly optimized Photoshopprogram will mean longer processing timesfor your files. That's the bad news if you havea deadline to meet. The good news is thatPhotoshop can be configured to run more effi-ciently. To optimize Photoshop, click the Edit(Win) or Photoshop (Mac) menu, point toPreferences, and then click Performance. ThePerformance preferences dialog box containsoptions that will help maximize the perform-ance of Photoshop.
 History StatesHistory States control the number of undosavailable. In fact, you can have up to 1,000undos (ever wonder who would make somany mistakes that they would need 1,000undos?). Unfortunately, increasing the numberof History States will ultimately increase theamount of RAM Photoshop uses to manage
 the History panel. Assigning more RAM tomanage History means less memory forPhotoshop to perform other operations, andwill reduce the performance of the pro-gram. If you are experiencing problemswith slow performance, lowering the num-ber of History States frees up more RAM,and permits Photoshop to operate moreefficiently.
 Scratch DiskWhen your computer doesn't have enoughRAM to perform an operation, Photoshopuses free space on any available drive,known as a Scratch Disk. Photoshoprequires 5 times the working size of the filein contiguous hard drive space. For exam-ple, if the working size of your file is 100MB, you will need 500 MB of contiguoushard drive space, or you will receive anerror message: Out of Scratch Disk Space (Ihate it when that happens). Using additionalhard drives gives Photoshop the ability to
 History States
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 divide the processing load and increase per-formance. Photoshop detects and displays allavailable internal disks in the Preferences dia-log box. Scratch disks must be physicallyattached to your computer (avoid networksand removable media, such as USB drives, orrewritable CDs or DVDs). For maximumspeed, avoid USB, and use 4- or 6-pinFireWire drives. Benchmark tests showFireWire drives provide up to a 20% speedimprovement when used as Scratch Disks.Think of saving one hour out of every five, orone full day out of every five. That's not toobad. For best results, select a scratch disk on adifferent drive than the one used for virtualmemory or any large files you're editing.
 Memory & Image CachePhotoshop functions in RAM (actually allapplications work within RAM). To run effi-ciently, Photoshop requires 5 times the work-ing size of the open document in available
 memory (some tests indicate 6 to 8 times).Strictly speaking, the more RAM you canassign to Photoshop, the more efficiently theprogram operates, especially when openinglarge documents. RAM usage is determined bythe working size of the document, not its opensize. As you add elements to a document, theworking size of the file increases.
 Cache Levels are screen redraws, or howmany versions of the current active documentPhotoshop saves. When you're working onlarge documents, more Cache Levels helpspeed up the redraw function, and makeimage manipulation proceed faster. However,they are held primarily in RAM, so the moreCache Levels you choose, the less RAM isavailable for other Photoshop functions. CacheTiles are the amount of data Photoshop storesor processes at once; use a larger tile size forlarger documents to speed up processing. Ifyou’re not sure what to set, use one of the pre-set buttons.
 RAM memoryallocation
 Available ScratchDisks
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 Photoshop's General preferences help you configure some of the morecommon features of the program. Color picker, image interpolation, andimage Smart Object settings, as well as the History log, are set up inGeneral preferences. Other options, such as beeping when an opera-tion is finished, auto-updating open documents, and using the Shift keyfor tool switching, can all be turned on or off in the Options area. TheColor Picker options allow you to select a color picker, either Adobe orthe OS, and a HUD color picker (in 8-bit and 16-bit documents). TheHistory Log lets you save all the History States performed on a particu-lar document. For example, when you open an image, all the adjust-ments and actions performed are saved in a text file. This gives youaccess to valuable information, and lets you reproduce the steps per-formed on one image to correct another.
 Setting GeneralPreferences
 Work with General Options
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click General.
 Click the Color Picker list arrow,and then select Adobe or another.operating system (Windows orMacintosh).
 Click the HUD Color Picker listarrow, and then select a colorpicker style, such as Hue Strip orHue Wheel.
 Click the Image Interpolation listarrow, and then select NearestNeighbor, Bilinear, Bicubic,Bicubic Smoother, BicubicSharper, and Bicubic Automatic.
 Select the various options youwant to use:
 ◆ Auto-Update Open Documents.Creates a link between theopen image and the image fileon disk.
 ◆ Beep When Done. Makes asound when an operation iscomplete.
 ◆ Dynamic Color Sliders.Previews color effects withinthe slider bars.
 ◆ Export Clipboard. Transfers acopied image to the operatingsystems clipboard.
 5
 4
 3
 2
 12 3 4
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 ◆ Use Shift Key For Tool Switch.Allows you to use the keyboardshortcut when two tools sharethe same slot in the toolbox.
 ◆ Resize Image During Place.Allows you to resize an imageduring a Place.
 ◆ Animated Zoom. Enablescontinuous-motion, smoothzooming in and out of yourdocument, and Scrubby Zoom.
 ◆ Zoom Resizes Windows.Forces the image window toresize when zoom is selected.
 ◆ Zoom With Scroll Wheel.Determines whether zooming orscrolling is the defaultoperation of the scroll wheel.
 ◆ Zoom Clicked Point to Center.Centers the zoom view on theclicked location.
 ◆ Enable Flick Panning. Enablesquick mouse movement overthe image instead of holdingdown the mouse.
 ◆ Vary Round Brush Hardnessbased on HUD VerticalMovement. Enables brushvariations (hardness andopacity) when vertically movingbrush HUD.
 ◆ Place or Drag Raster Images asSmart Objects. Converts rasterimages to Smart Objects whenyou place or drag them.
 ◆ Snap Vector Tools andTransforms to Pixel Grid.Enables the snapping of vectortools and transformations to thepixel grid.
 TROUBLE? Some optionsrequire the Use GraphicsProcessor option enabled inPerformance Preferences to work;see details on page 75.
 Select the History Log check boxand then set the log options youwant to use.
 Click OK. 7
 6
 7
 6
 5
 Resetting Photoshop PreferencesIf your preference settings in Photoshop are causing display or per-formance problems, you can reset Photoshop preferences back totheir defaults. To reset Photoshop preferences, press Shift+Ctrl+Alt(Win) or Shift+Option+A (Mac) immediately after you startPhotoshop, and then click Yes to delete the Adobe PhotoshopSettings File.
 For Your Information
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 Sooner or later, you'll have to save the file (document) you've created inPhotoshop. Photoshop lets you save files using different formats, includ-ing TIFF, EPS, JPEG, or BMP. The File Handling preferences provide sev-eral options that modify what information is saved with a file. You canalso set options to automatically save the file based on a time interval orsave the file in the background, which allows you to keep working whilePhotoshop saves behind the scenes; a progress information appears inthe Document tab and Status bar. If Photoshop crashes unexpectedly,the program automatically tries to recover and open your file. Imagepreviews are typically very small, adding very little to the file size of thesaved document. Once saved you may want to open, print, and possiblyeven modify the document using other image-editing applications. TheFile compatibility options help you use or save a file, including CameraRaw (New!), that will be transformed in Photoshop or transportable toother applications.
 Setting File Handling Preferences
 Work with File Handling Options
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click File Handling.
 Select the File Saving Options youwant to use:
 ◆ Image Previews. Select from:Always Save, Never Save, orAsk When Saving.
 ◆ Icon. Saves previews of theimages (Mac).
 ◆ Windows Thumbnail. Savespreviews viewable when usingthe Win File Open command(Mac).
 ◆ Append File Extension. Choosewhether or not to append thefile extension (Mac).
 ◆ Use Lower Case (Mac) or FileExtension (Win). Choose tohave upper or lower caseextensions.
 ◆ Save As To Original Folder.Saves the file to original folderas the default.
 ◆ Save in Background. Photoshopautomatically saves in thebackground while you work.
 ◆ Automatically Save RecoveryInformation Every. Savesdocument information forrecovery based on an interval.
 2
 12
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 Select the File Compatibility optionsyou want to use:
 ◆ Camera Raw Preferences Clickto choose from options such asdefault image settings, cachesize, DNG file handling, andwhether or not to open JPEGand TIFF files with Camera Raw.
 ◆ Prefer Adobe Camera Raw forSupported Raw Files. Opensupported raw files in CameraRaw.
 ◆ Use Adobe Camera Raw toConvert Documents from 32 bitto 16/8 bit. Converts 32-bit rawdocuments to 16/8-bit (New!).
 ◆ Ignore EXIF Profile Tag. Ignorescolor space metadata attachedto digital camera images.
 ◆ Ignore Rotation Metadata.Ignore metadata attached todigital camera images.
 ◆ Ask Before Saving Layered TIFFFiles. Lets you create multi-layered documents, and thensave them using the TIFF format.
 This is a distinct advantagewhen you need to use multi-layered files and you don't wantto save them using Photoshop'sproprietary format (PSD).
 ◆ Disable Compression of PSDand PSB Files. Disablescompression of files.
 ◆ Maximize PSD and PSB FileCompatibility. Lets you savePSD files that can be opened inearlier versions of the programand PSB (Large DocumentFormat) files.
 Select the Enable Adobe Drivecheck box to enable Adobe Drive inyour work process.
 Enter the number of files (up to 30)to keep in the Recent File List box.
 Click OK.6
 5
 4
 3
 54
 6
 3
 Camera Raw Preferences
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 Working with Interface preferences gives you control over whetherPhotoshop displays or hides user interface features. You can changethe user interface display by color theme or some elements by aselected color and border. For example, you can show the programwindow in four color themes in shades of gray or the Application iconin color or grayscale, show channels in color, or show selected menuitems in user-defined colors. Interface preferences also allow you touse gestures with a tablet and pen, show descriptive labels when yourcursor is placed over an option, automatically collapse icon panelswhen you click away, remember panel locations for the next use, andenable text drop shadows. You can also change the size of the text fonton the Options bar, panels, and tool tips, restore all panels back to theirdefault workspaces, as well as choose where to show transformationvalues.
 Setting InterfacePreferences
 Work with Interface Options
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Interface.
 Select the Interface options:
 ◆ Color Theme. Choose from fourshades of gray. (Dark isdefault).
 ◆ Screen Modes. Choosebackground and border colorsfor the three screen modes.
 ◆ Auto-Collapse Iconic Panels.Automatically collapses iconpanels when you click away.
 ◆ Auto-Show Hidden Panels.Hidden panels will temporarilyappear when you point to theedge of the application window.
 ◆ Open Documents as Tabs.Opens documents in onewindow with tabs.
 ◆ Enable Floating DocumentWindow Docking. Allowsfloating document windows todock when you move them.
 ◆ Show Channels In Color.Allows you to view channels inthe Channels panel in color.
 ◆ Show Menu Colors. Displaysmenu items in user-definedcolors.
 2
 12
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 ◆ Show Tool Tips. Shows labelswhen your cursor is placedover an option.
 ◆ Enable Gestures. Allows theuse of gestures with a tabletand pen.
 ◆ Enable Text Drop Shadows.Select to have text dropshadows on panel labels.
 ◆ Show Transformation Values.Select where to showtransformation values near thecursor: Never, Top Left, TopRight, Bottom Left, or BottomRight.
 To restore all Photoshop panelsback to their default workspaces,click Restore Default Workspaces.
 Select the UI Text settings youwant to use:
 ◆ UI Language. Choose a defaultlanguage.
 ◆ UI Font Size. Choose a size forinterface fonts.
 Click OK.5
 4
 3
 3 5
 4
 Did You Know?You can turn a text box into a slider.You can use any text box which dis-plays a numerical value, such as fontsize, like a slider. Point to the name ofthe box (which changes the cursor to ahand with arrows), and then move themouse left to decrease or right toincrease the displayed number.
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 Photoshop's Sync Settings preferences (New!) allows you to specifythe settings you want to synchronize to an Adobe Creative Cloudaccount, which you can use on other computers with Photoshop.Creative Cloud is a membership-based cloud solution that allows you toaccess Adobe software, tools, services, personal files, tutorial videos,and sync program settings online from any computer or device. In orderto sync program settings (New!) and access online content on CreativeCloud and Adobe.com, you’ll need to sign in to the service with yourAdobe ID. If you’re not signed in when you start Photoshop, you’ll beasked to do so. When you’ve synced settings (New!) on Creative Cloudfrom another computer and there is a conflict, you’ll be asked if youwant to sync settings (keep local or remote) to this computer.
 Changing SyncSettings Preferences
 Change Sync SettingsPreferences
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Sync Settings.
 ◆ You can also click the Edit(Win) or Photoshop (Mac),point to account address, andthen click Manage SyncSettings.
 Select the Sync Settings checkbox to sync the settings you wantor deselect to not sync anysettings at all.
 Select or deselect the Photoshopsettings you do or don’t want tosync to the Creative Cloud.
 Click the When Conflict Occurs listarrow, and then select an option tospecify how you want to deal withsync conflicts.
 ◆ Ask My Preference.
 ◆ Sync Local Settings.
 ◆ Sync Cloud Settings.
 ◆ Keep Latest File.
 Click OK.5
 4
 3
 2
 1
 532
 4
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 Work with Sync Settings
 When you start Photoshop andsettings are synced with CreativeCloud from another computer, clickKeep Local or Keep Remote to setsync settings (New!).
 To sign in to your Creative Cloudaccount, click the Help menu,click Sign In, click Sign In Now,create an account or enter your
 ◆ To sign out, click the Helpmenu, click Sign Out (accountaddress), and then click Signout.
 Click the Edit (Win) or Photoshop(Mac) menu, and then point toaccount address.
 Use any of the following:
 ◆ Sync Settings Now. Syncs thesettings to your Creative Cloudaccount based on your SyncSettings preferences.
 TIMESAVER Click the SyncSettings button on the Status bar,and then click Sync Settings Now.
 ◆ Manage Sync Settings. OpensSync Settings preferences.
 ◆ Manage Creative CloudAccount. Opens your defaultweb browser, displaying yourCreative Cloud account, whereyou can make changes.
 If a conflict occurs, click the SyncSettings button, and then clickKeep Local or Keep Remote. If youwant to remember it, select theRemember my choice check box.
 5
 4
 3
 2
 1
 4
 2
 3
 Click Sync Setting button to display sync status and command
 See AlsoSee “Using the Status Bar” on page 30for information on Sync Setting buttonon the Status bar.
 1
 5 Sync Settings Preferences conflict
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 4
 We communicate with Photoshop using various devices, such as adrawing tablet, mouse, touch screen, track pad, or keyboard.Photoshop communicates with us using visual cues, the most promi-nent one being the shape of the cursor. For example, when a cursorlooks like an I-beam, this typically means it's time to enter text, or whenthe cursor looks like a magnifying glass, clicking on the image expandsthe view size. When you paint, you can specify how Photoshop displaysthe brush tip. Working with the Cursors preferences gives you controlover how Photoshop communicates with you.
 Setting CursorsPreferences
 Work with Cursors Options
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Cursors.
 Select the Painting Cursorsoptions you want to use:
 ◆ Standard. Painting cursors looklike their toolbox icons.
 ◆ Precise. Painting cursorsappear as crosshairs.
 ◆ Normal Brush Tip. Paintingcursors appear with the shapeof the active brush tip.
 ◆ Full Size Brush Tip. Shows thefull size of the brush tip,including feathered edges.
 ◆ Show Crosshair In Brush Tip.Displays a crosshair in thecenter of the brush tip.
 ◆ Show Only Crosshair WhilePainting. Displays a crosshairwhile using a paint brush.
 Select the Other Cursors optionsyou want to use:
 ◆ Standard. Painting cursors looklike their toolbox icons.
 ◆ Precise. Painting cursorsappear as crosshairs.
 ◆ Brush Preview. Choose a colorfor brush editing preview.
 Click OK.4
 3
 2
 1
 3
 Toggling Between Precise and Standard Tools
 Pressing the Caps Lock key while using a painting cursor toggles thetool between the precise and brush size options, and pressing the CapsLock key when using any other cursor toggles between standard andprecise options.
 For Your Information
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 Transparency & Gamut preferences control how Photoshop displaystransparent areas of a document (commonly called the checkerboard),as well as the color and opacity of areas of an image that fall outside ofthe CMYK (Cyan, Magenta, Yellow, and Black) color mode. It's impor-tant to understand that transparency in Photoshop does not alwaystranslate into transparency after you save the file. For example, theJPEG format does not support transparency. When you save the file,Photoshop will fill the transparent areas of the image with a matte color(the default is white). In addition, the Gamut Warning may be activatedbecause a monitor displays color information using RGB, and has moreavailable saturation values than a CMYK document. Using a differentink or spot colors can sometimes fix an out-of-gamut color. For trans-parency it's important to remember that unless you're printing the doc-ument directly in Photoshop, it's the format you choose that determinesif the transparent areas will be saved, and the Gamut Warning is thereto warn you of any areas that may not print the way you expect. To acti-vate the gamut warning option, open a document, click the View menu,and then click Gamut Warning. Out-of-Gamut areas of the image willdisplay with the color and opacity chosen in preferences.
 ControllingTransparency& Gamut Preferences
 Control Transparency & Gamut Options
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Transparency &Gamut.
 Select the Transparency Settingsoptions you want to use:
 ◆ Grid Size. Allows you to selecta transparency grid size.
 ◆ Grid Colors. Allows you tochoose the color scheme forthe transparency grid.
 Select the Gamut Warning optionsyou want to use:
 ◆ Color. Choose a color to maskareas of an image that moveout of the CMYK color space.
 ◆ Opacity. Enter a value from 0%to 100%. Opacity determineshow much of the Color Overlaymasks the original image pixels.
 Click OK.4
 3
 2
 1
 2
 3
 4
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 While changing the measurable units and rulers do not affect outputquality, they do help to measure information in a document consistentwith the specific output device. Ruler Units give you precise informa-tion on the width and height of the active document. The Column Sizemeasurements provide information that Photoshop needs to createdocuments with columns, such as newspapers, magazines, brochures,etc. The New Document Preset Resolutions area lets you select spe-cific resolution values when creating new documents. Insert the valuesyou'll use most often in the creation of a new Photoshop document.
 Working with Units & Rulers
 Work with Units & RulersOptions
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Units & Rulers.
 Select the Units options you wantto use:
 ◆ Rulers. Sets a defaultmeasuring system for the Ruler bar.
 For example, pixels would bemost common for imagesdisplayed on a monitor, andpicas or inches most commonfor output to press or printer.
 ◆ Type. Use to measure type withpixels, points, or millimeters.
 2
 1
 2
 Did You Know?You can switch between ruler meas-urements without going toPreferences. To change the defaultmeasurement system of the Ruler bar,simply move into the Ruler bar, andthen right-click your mouse. A list ofavailable measurement options will beinstantly available.
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 Select the Column Size settingsyou want to use:
 ◆ Width. Choose a measurementsystem and numerical value forcolumn width.
 ◆ Gutter. Choose a measurementsystem and numerical value forgutter (the space between thecolumns).
 When you choose ameasurement system (points,inches, or centimeters),Photoshop changes the valueto correspond to the type ofmeasurement system.
 Select the New Document PresetResolutions settings you want touse:
 ◆ Print Resolution. Select a printresolution and measurementvalue for default printing.
 ◆ Screen Resolution. Select aprint resolution andmeasurement value for defaultscreen display.
 Click the PostScript or Traditionaloption measuring systems forPhotoshop's type tool (PostScriptis the most widely used).
 Click OK.6
 5
 4
 3
 5
 6
 4
 3
 Did You Know?You can choose what type ofPoint/Pica size to use. Click PostScript(72 points/inch) or click Traditional(72.27 points/inch). PostScript is morewidely used, and Photoshop defaults tothis option.
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 Guides, Grid & Slices preferences help keep a multi-layered documentin proper order. For example, using Guides can help you line up buttonson a web interface, or make sure specific design elements are pre-cisely placed within the document window. The Guides option lets youselect the color and style of the guides placed within a Photoshop doc-ument. Guides are placed within the image by dragging them from thehorizontal or vertical Ruler bars in the active document. The Gridoptions let you decide on a color, style, and layout for Photoshop's gridsystem. The Slices option defines the visible color of a slice, andwhether Photoshop displays a number value for each slice.
 Working with Guides,Grid & Slices
 Work with Guides, Grid & SlicesOptions
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Guides, Grid &Slices.
 Select the Guides options youwant to use:
 ◆ Color. Select a default color fordisplaying guides.
 ◆ Style. Select a default (Lines orDashed Lines) for displayingguidelines.
 Select the Smart Guides optionsyou want to use:
 ◆ Color. Select a color for usewith Smart Guides.
 3
 2
 1
 2
 3Did You Know?
 You can change a horizontal guide intoa vertical guide, and vice versa. Moveinto the Ruler bar and drag a guide intothe document window. Before releas-ing the mouse, hold down the Alt (Win)or Option (Mac) key. The guide auto-matically switches directions.
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 Select the Grid options you wantto use:
 ◆ Color. Select a default color fordisplaying grids.
 ◆ Style. Select a default style(Lines, Dashed Lines, or Dots)for displaying the grid.
 ◆ Gridline Every. Enter a value forhow often the grid lines appearwithin the active document.
 ◆ Subdivisions. Enter a value forhow many subdivisions (lines)appear between each maingridline.
 Select the Slices options you wantto use:
 ◆ Line Color. Select a default linecolor for displaying documentslices.
 ◆ Show Slice Numbers. Selectthe check box to display anumber for each slice in theupper left corner of the slice.
 IMPORTANT When you selecta line color, choose a color that isdifferent than the grid and guideline colors. That way you caneasily identify grids and guides foruser-created lines.
 Click OK.6
 5
 4
 5
 6
 4
 Did You Know?You can change color choices forGuides, Grid & Slices. Not satisfiedwith the color choices offered by thecolor and style menus? Click on theColor boxes located on the right side ofthe Preferences dialog box, and selectany color from the Color Picker.
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 A plug-in is an external code modal that extends the functionality of aprogram. Photoshop comes with several installed plug-ins, such asCamera Raw and Filter Gallery; however, you can install other third-party ones too. If you want to use third-party plug-ins, you’ll need toplace or install them (unless specified by the developer) in the defaultPhotoshop Plug-ins folder—located in the main Adobe Photoshopfolder—in order to make them available in Photoshop; the AdditionalPlug-ins Folder is no longer available. Plug-ins preferences allows youto specify options relating to plug-ins, filters, or extension panels. For fil-ters, you can specify whether you want to show all Filter Gallery groupsand names on the Filter menu. For extension panels, you can specifywhether to allow extensions to connect to the Internet and load exten-sion panels for use on the Extensions submenu on the Window menu.
 Setting Plug-InsPreferences
 Work with Plug-Ins Options
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Plug-Ins.
 Select the Show all Filter Gallerygroups and names check box todisplay all Filter Gallery groups andnames on the Filter menu.
 Select the Extension Panelsoptions you want to us:
 ◆ Allow Extensions to Connect tothe Internet. Select to allextensions to connect to siteson the Internet.
 ◆ Load Extension Panels. Selectto load extension panels, suchas Kuler and Adobe Exchange,which become available on theExtensions submenu on theWindow menu.
 Click OK.4
 3
 2
 12 4
 3
 Did You Know?You can find out about installed plug-ins. Click the Help (Win) or Photoshop(Mac) menu, point to About Plug-ins,and then select a plug-in to find outabout it.
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 Selecting ScratchDisks
 Work with Scratch DisksOptions
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Performance.
 Select the check box next to thescratch disk you want to use orclear the check box to remove it.
 IMPORTANT Photoshop holdsscratch disk space as long as theapplication is open. To deletescratch disk space you must closePhotoshop.
 Click OK.3
 2
 1
 3
 Performance preferences are available to help you get the best per-formance out of your computer by letting you choose one or more harddrives for scratch operations. When your computer doesn't haveenough RAM to perform an operation, Photoshop uses free space onany available drive, known as a Scratch Disk. Photoshop runs fasterwhen you divide the Scratch Disk workload. Scratch operations areperformed on your hard drive and take place when Photoshop is usingone of its many filters and adjustments. Photoshop detects and displaysall available disks in the Performance preferences dialog box, whereyou can select the disks you want to use. By assigning additional harddrives to the task, you speed up Photoshop's overall performance.Scratch Disk changes take effect the next time you start Photoshop.
 2
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 Memory Usage and History & Cache preferences give you control overhow much RAM is assigned to Photoshop, and how much memory isallocated to screen redraws (Image Cache). Photoshop, being a high-performance application, requires a fairly large amount of RAM.Photoshop uses many operations that affect RAM: History States, Undo,Clipboard, and Cache. Cache Levels are screen redraws, or how manyversions of the current active document Photoshop saves. When you'reworking on large documents, more Cache Levels help speed up theredraw function, and make image manipulation proceed faster.However, they are held primarily in RAM, so the more Cache Levels youchoose, the less RAM is available for other Photoshop functions. CacheTiles are the amount of data Photoshop stores or processes at once; usea larger tile size for larger documents to speed up processing. If you’renot sure what to set, use one of the preset buttons. By fine-tuningPhotoshop's engine, you increase its overall speed, and you'll get moredesign miles to the gallon.
 Allocating Memory &Image Cache
 Allocate Memory & ImageCache Options
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Performance.
 Select the History & Cache optionsyou want to use:
 ◆ Optimize. Click a button to usea preset cache level.
 ◆ Tall and Thin. Use for smalldocuments and many layers(dozens to hundreds).
 ◆ Default. Use for general use.
 ◆ Big and Flat. Use for largedocuments (hundreds ofmegapixels) with few layers.
 ◆ History States. Enter theamount of History States stepsyou want to keep as undos; youcan enter up to 1,000. The moreHistory States used, the moreRAM is required, whichimpacts performance.
 ◆ Cache Levels. Select a numberfrom 1 to 8. Set to 2 or more foroptimum GPU performance.
 2
 1
 2
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 ◆ Cache Title Size. Specify a sizefor the amount of data Photo-shop stores or processes atonce. Use a large amount forlarge documents to maintain agood processing speed.
 Enter the percentage of RAM usedin the Let Photoshop Use box.
 Photoshop needs about 5 times thesize of the open document ofunused RAM to operate efficiently.
 IMPORTANT Never selectupwards of 100% Memory Usagefor Photoshop, leaving little for theoperating system or any other openprograms. Any changes made forallocating memory and imagecaching will take place the nexttime you start Photoshop.
 If you have a video card installed,the video card name appears.Select the Use Graphics Processorcheck box (which uses OpenGL) touse the enhanced speed andsmoothness of graphic/3Drendering and navigation. ClickAdvanced Settings to selectadditional options:
 ◆ Drawing Mode. Select a mode(Basic, Normal, or Advanced) touse different amounts ofmemory processing.
 ◆ Use Graphics Processor toAccelerate Computation. Selectto access available GPU powerto speed up computation.
 ◆ Use OpenCL. Select to accessavailable parallel processingpower; uses the GPU toaccelerate filter performance.
 ◆ Anti-alias Guides and Paths.Select to enable anti-aliassmoothing for better displaywith GPU hardware.
 Click OK.5
 4
 3
 53
 4
 Supporting the Graphics ProcessorSome features in Photoshop require a video card processor, or GPU(Graphics Processing Unit), and some VRAM memory (typically 512MB) for better performance or to function at all. The GPU featuresincludes many filters, 3D, Scrubby Zoom, Animated Zoom, Flick-pan-ning, Rule of thirds crop grid overlay, Rotate the canvas, Adobe ColorEngine (ACE), and pixel grid to name a few. The GPU uses OpenGL(Open Graphics Library) to render and accelerate 2D and 3D graphicsand OpenCL (Open Computing Language) for parallel processingacceleration. Along with the GPU, Photoshop uses the Adobe MercuryGraphics Engine (MGE), which provides near instant results whenworking with Liquify, Warp, Lighting Effects, and Oil Paint filters.
 When you start Photoshop, it runs the GPU Sniffer to check for prob-lems. If a problem occurs, the GPU is turned off and a warning dialogbox appears, providing status and correction details. If you have prob-lems with the GPU, update your display drivers or replace your videocard. If problems still exist, turn off OpenGL, which is deselecting theUse Graphics Processor check box in Performance preferences. Youcan also try resetting preferences; see details on page 59.
 For Your Information
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 Although Photoshop is not by definition a typesetting application, suchas Adobe InDesign, it does have some very powerful type features. Forexample, Adobe Photoshop allows you to output PostScript text to aprinter with a PostScript option. This way you will not need to placePhotoshop images into type-intensive applications, such as InDesign orIllustrator, just to create a few lines of text. In addition, Photoshop'stype menu lets you see fonts exactly as they will print or display. Fordesigners who use a lot of fonts, this WYSIWYG (What You See Is WhatYou Get) font menu is a timesaver. You can use Type preferences tohelp you select the type and font options you want to use.
 Setting TypePreferences
 Work with Type Options
 Click the Edit (Win) or Photoshop(Mac) menu, point to Preferences,and then click Type.
 Select the Type options you wantto use:
 ◆ Use Smart Quotes. Select touse left and right quotationmarks.
 ◆ Enable Missing GlyphProtection. Select toautomatically select incorrect,unreadable charactersbetween roman and non-roman(Japanese or Cyrillic) fonts.
 ◆ Show Font Names In English.Select to display non-romanfonts using their roman names.
 ◆ Choose Text Engine Options.Select to display East Asian orMiddle Eastern.
 Click OK.
 IMPORTANT Photoshop usesPostScript measuring systems tosize fonts. Therefore a 72-pointfont will print 1 inch tall. This letsyou know how big the fonts willappear when output to print.
 3
 2
 12 3
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 The Preset Manager gives you one place to manage brushes, swatches,gradients, styles, patterns, contours, custom shapes, and preset tools.The Preset Manager can be used to change the current set of presetitems and create new libraries of customized sets. Once a library isloaded in the Preset Manager, you can access the library's items in alllocations where the preset is available. Changes made in the PresetManager are global and are applied every time you open Photoshop.When you save a new preset, the name appears in the dialog box forthe specific option you selected. You can also migrate presets from ear-lier versions as well as import/export presets.
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 Managing Librarieswith the PresetManager
 Create a New Preset
 Click the Edit menu, point toPresets, and then click PresetManager.
 ◆ To migrate presets from earlierPhotoshop CS versions, clickthe Edit menu, point to Presets,and then click Migrate Presets.
 Click the Preset Type list arrow,and then select the options.
 Click the Options list arrow, andthen select from the availablepresets to add them to the currentitem list.
 To remove any items in a newpreset, click a thumbnail, and thenclick Delete.
 To reorganize their order, click anddrag the thumbnails to newpositions within the view window.
 To change a preset name, click athumbnail, click Rename, changethe name, and then click OK.
 Click one or more thumbnails(Ctrl+click (Win) or A+click(Mac), and then click Save Set.
 Enter a new set name, and thenselect a location to store the set.
 The set is saved with the ABRextension.
 Click Save, and then click Done.9
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 Importing and Exporting PresetsYou can migrate your presets from previous versions of Photoshop orimport/export them for back up purposes or to share with others.When you start Photoshop for the first time, it will ask you whetheryou want to migrate presets. If you decline, you can still do it; clickthe Edit menu, point to Presets, and then click Migrate Presets. Toimport or export presets, click the Edit menu, point to Presets, andthen click Export/Import Presets. In the Export/Import dialog box,select the Export Presets or Import Presets tab. For export, selectyour presets (left column), move the presets to export (right col-umn), and then click Export Presets (select location, and then clickOpen). For import, click Select Import Folder (select it, and thenclick Open), select source presets, move the presets to import (rightcolumn), and then click Import Presets.
 For Your Information
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78 Chapter 3
 The Photoshop workspace consists of a document surrounded by anApplication frame (Mac only), Options bar, toolbox, and over 20 floatingpanels. Depending on how you work, your workspace may reflect anycombination of the above. For example, when you work with text, youwould need the Character and Paragraph panels, but you might not needthe Styles or Histogram panel. Rather than making you redesign yourworkspace every time you begin a new project, Photoshop gives youways to use predefined workspaces or create your own customizedworkspaces. Photoshop includes predefined workspaces includingEssentials (Default), What’s New, 3D, Motion, Painting, Photography, andTypography. If you're curious about all the new features in PhotoshopCC, you can choose a drop-down menu system with all the new featureshighlighted. You can access workspaces by using the Workspaces menuon the right side of the Options bar or the Workspace submenu on theWindow menu. When you create or change a workspace, Photoshopauto-saves any changes (even if you exit Photoshop) until you reset it.
 Using and CustomizingWorkspaces
 Display a Workspace
 Click the Workspaces menu on theOptions bar, or click the Windowmenu, and then point toWorkspace.
 Select a panel option:
 ◆ Custom panel name. Displays acustom panel layout that youcreated.
 ◆ Essentials (Default), What’sNew, 3D, Motion, Painting,Photography, or Typography.Displays panel layouts createdby Adobe for specific purposesin Photoshop.
 2
 1
 Did You Know?You can reset a workspace. You canreset a workspace to its original con-figurations. Select the workspace, clickthe Workspace menu or click theWindow menu, point to Workspace,and then click Reset workspace name.
 1
 2
 Defaultworkspaces
 Workspaces menu on theright side of Options bar
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 3
 Create a Customized Workspace
 Arrange the panels into a specificworking order.
 Click the Workspaces menu on theOptions bar, or click the Windowmenu, and then point toWorkspace.
 Type a name for the workspace.
 Select check boxes to saveKeyboard Shortcuts or Menus.
 Click Save.
 Delete a Customized Workspace
 Click the Workspaces menu on theOptions bar, or click the Windowmenu, and then point toWorkspace.
 Click the Workspace list arrow,and then click the workspace youwant to delete, or click All CustomWorkspaces.
 ◆ You cannot delete the currentworkspace. You must switch toanother workspace first.
 Click Delete, and then click Yes toconfirm the deletion.
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 See AlsoSee “Setting Interface Preferences” onpage 62 for more information on reset-ting all Photoshop panels back to theiroriginal settings.
 2
 Working with the Application FrameThe Application frame is the Photoshop window that groups all theworkspace elements into a single window. When you move or resizethe Application frame, all the workspace elements within it change sonothing overlaps. This allows you to position the Photoshop windowand other application windows side by side, so you can work togetheron the same screen or on multiple monitors. If you prefer to use thetraditional Mac user interface, you can turn off the Application frame.Click the Window menu, and then click Application Frame to turn it offor on (Mac only).
 For Your Information
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80 Chapter 3
 If you want to build a specialized workspace with custom panels inPhotoshop, you can use the Adobe Configurator panel utility. The exter-nal program is available as a separate download from Adobe atwww.labs.adobe.com. With Configurator, you can drag and drop tools,menu items, scripts, actions, and other objects into a panel to build aspecialized workspace design. In addition, you can access anything onthe web, such as blogs, videos, or e-mail, with these specialized designsthat leverage built-in Flash support. When you’re done creating adesign, you can export it for use in Photoshop or InDesign.
 Building SpecializedWorkspaces
 Build a Specialized Workspacewith Configurator
 Start Adobe Configurator 3.0 orlater from the Start menu or screen(Win) or the Applications folder(Mac).
 Click the File menu, and then clickNew Panel.
 Click the Select Product list arrow,and then click Photoshop CC orInDesign CC.
 Click OK.
 Use the controls on the right toenter a panel name, and customizethe layout and functionality.
 Drag the items you want to add toyour panel from the left pane to thenew panel.
 To save the panel file (GPC), clickthe File menu, and then click SavePanel As. Enter a name, specify alocation, and then click Save.
 Click the File menu, and then clickExport. Specify the location of thePlug-In Panels folder (the default),click Select, and then click OK.
 Click the File menu, and then clickExit.
 In Photoshop or InDesign, click theWindow menu, point to Extensions,and then select your new panel.Restart Photoshop or InDesign afterexporting your panel for the firsttime.
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 http://www.labs.adobe.com
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Chapter 3 Customizing the Way You Work 81
 Photoshop's pull-down menus actually contain hundreds of options (yes,I did say hundreds). If you find navigating through menus a hassle, thenAdobe has the answer to your problem with a customizable user inter-face. In Photoshop, you have the ability to choose what menu itemsappear on the pull-down menus and you can even colorize certain menuitems for easier visibility. If you no longer want to use a customized set,you can delete it and restore Photoshop back to the default.
 Creating a CustomizedUser Interface
 Create and Work with aCustomized User Interface
 Click the Window menu, point toWorkspace, and then clickKeyboard Shortcuts & Menus.
 Click the Menus tab.
 To create a new set based on thecurrent active set, click the Createa New Set button, enter a name,and then click Save.
 Click the Set list arrow, and thenselect a listing of modified UserInterfaces.
 ◆ Delete Set. Select the set, andthen click the Delete button.
 ◆ Restore Original Set. Select thePhotoshop Default set.
 Click the Menu For list arrow, andthen click Application Menus orPanel Menus with the items youwant to modify.
 Click an arrow (left column) toexpand the menu that contains thecommand you want to modify.
 Click the Visibility icon associatedwith a command to show or hidethe command.
 Click the Color list arrow, andselect a color for the selectedcommand.
 Click the Save All Changes buttonto save the new customized UserInterface.
 Click OK.10
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 109 Delete button
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82 Chapter 3
 A wise man once wrote "time is money," and Photoshop is a programthat can consume a lot of time. That's why the Photoshop applicationuses keyboard shortcuts. Keyboard Shortcuts, as their name implies, letyou perform tasks in a shorter period of time. For example, if you want toopen a new document in Photoshop, you can click the File menu, andthen click New, or you can abandon the mouse and press Ctrl+N (Win)or A+N (Mac) to use shortcut keys. Using shortcut keys reduces theuse of the mouse and speeds up operations. In fact, a recent study inthe American Medical Journal suggested that the use of shortcut keyssignificantly cuts down on repetitive stress, and reduces instances ofcarpal tunnel syndrome. Photoshop raises the bar by not only giving youhundreds of possible shortcut keys, but also actually allowing you todefine your own shortcuts.
 2
 Defining Shortcut Keys
 Create a Keyboard Shortcut
 Click the Edit menu, and then clickKeyboard Shortcuts.
 Click an arrow (left column) toexpand the menu that contains thecommand for which you want tocreate a shortcut.
 Select an item from the Commandslist.
 Use the keyboard to create thenew shortcut. For example, pressCtrl+N (Win) or A+N (Mac).
 Click Accept.
 Click OK.6
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 Did You Know?You can save time using shortcut keys.According to several time and motionstudies, using shortcut keys can actu-ally save a computer user 1 hour out ofevery 8 in a work day. Working with Shortcuts
 In addition to adding shortcuts, you can delete any of them you don'twant and even print out a summary of shortcuts defined inPhotoshop. Shortcuts can be used for the Application and Panelmenus, as well as for your tools in the toolbox. Click the Edit menu,click Keyboard Shortcuts, and then use the appropriate buttons,such as Add Shortcut, Delete Shortcut, or Summarize, to perform thetasks you want.
 For Your Information
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 Index
 Aabsolute colorimetric rendering intent, 469accented edges filter effect, 391Acrobat 4 color system, 472actions, 393-414. See also droplets
 adding command to action, 400buttons, converting to, 395conditional, insert, 394, 406Conditional Mode Change command,
 446copying, 404
 sets, copying between, 408deleting command from action, 401enhanced scripting of, 411files, saving actions as, 410modal controls, working with, 402moving actions between sets, 408multiple sources, calling actions from,
 405names for action sets, 408new action, building, 396non-recordable commands, inserting,
 407order of commands, changing, 403pauses in, 402play options, 412playback of command, controlling, 399recording actions, 397running actions inside actions, 405running scripts, 411saving, 393
 files, saving actions as, 410sets, saving actions into, 409
 setscreating, 409files, saving actions as, 410moving and copying between, 408names for, 408
 speed of executing, 403stop to action, adding, 398
 Actions dialog box, 410Actions panel, 393-395. See also actionsAdaptive Wide Angle filter, 372-373Add Layer Mask button, 263, 265
 with type masks, 353Add Layer Styles button, 265, 307, 322Add New Layer button, 117Add Noise filter, 166Additive RGB, 196adjustment layers, 115
 advantages of, 155blending modes with, 162composite layers, creating, 159creating, 156deleting, 161file formats for, 156filters on masks, 165grouping, 160HDR Toning, 226-227Levels adjustment for, 188-189linking layers in, 131, 159masks with, 164-165merging, 158-159modifying, 157opacity, working with, 162pain on adjustment masks, 164regular layer, converting to, 161temporary composite images, 159
 Adobe (ACE) color management, 75, 476Adobe Acrobat Reader, 4Adobe Application Manager, 4, 24-25, 546Adobe Bridge. See BridgeAdobe Creative Cloud, 1, 543-544
 Adobe ID, 1-5, 25-26, 563-564sign in and out, 4-5, 25, 564sync settings to, 30, 64-65
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 Adobe Drive, 28, 30Adobe Exchange panel, 544, 563Adobe Extension Manager, 544, 562, 563Adobe ExtendScript Toolkit 544, 559Adobe Flash. See SWF filesAdobe Gamma utility, 464Adobe Help Center, 4, 26-27Adobe ID, 1-5, 25-26, 563-564Adobe Illustrator. See IllustratorAdobe Media Encoder, 544, 560-561Adobe Mercury Graphics Engine (MGE), 75Adobe Updater Preferences dialog box, 4,
 24-25Airbrush, 183, 237, 241align layers, Auto, 132-133alpha channels
 different file formats, saving as, 429saving, 28
 altitude values for Bevel and Emboss style, 311
 anchor points. See also pathswith Magnetic Lasso tool, 89
 Android, 560-561angle values
 for Bevel and Emboss style, 311for Drop Shadow style, 308with Smart Sharpen filter, 178
 animations, work with, 524-525animated GIFs
 creating, 522-523annotations. See notesanti-aliasing
 for Bevel and Emboss style, 312Character panel selections, 333Column Marquee tools and, 86with Custom Shapes tool, 247for Drop Shadow style, 309for Inner Glow style, 321with Line tool, 245and Magic Eraser tool, 256multi-page PDFs to PSDs, converting,
 449for Outer Glow style, 319with Paint Bucket tool, 253for paths with fill, 300setting options for, 335with Type tool, 329, 331
 Apple Computers. See also Macintosh
 Apple DevicesMedia Encoder for, 560-561
 AppleScript, 411Application frame, 78-79Arc and Arch styles of warped text, 336arrange multiple documents, 42arrowheads with Line tool, 245Art History brush, 141, 152artistic filters, 356
 for layer mask borders, 267Asian text options, 76audio, adding to a video layer, 521Auto-Align, 132-133Auto-Blend, 132-133Auto Color command, 213Auto Contrast and Color command, 213Auto Contrast command, 213Auto Erase, 244Auto Save, 28-29, 60-61Auto Tone command, 212Auto levels command, 214Automate commands, 443-462
 BBackground Eraser tool, 254-255backgrounds, 115, 232-233
 converting into layers, 122-123default and switching of colors, 233Foreground and Background colors,
 232-233Merge Visible option, 123multi-layered documents into back-
 grounds, converting, 123Screen Mode determining, 37
 Barrel distortion, 170-171baseline shift, 327
 Character panel selections, 333batch commands with Bridge, 460-461Batch File Processing, 444-445BBEdit, 411Behance, sharing on, 442
 Status bar, 30Bevel and Emboss style
 contours, working with, 311-312with layer masks, 265Texture option for, 312-313with type masks, 350-351
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 working with, 310-311Bicubic Sharper method, 22, 58Bicubic Smoother method, 22, 58Bilinear method, 22, 58Bird’s Eye view, 38-39bit depth, 192bitmap color modes, 195, 199bitmapped fonts, 331black and white. See also Grayscale
 color modeThreshold adjustment for, 225Black & White adjustment, 229
 Black Point Compensationfor converting color space, 477for soft-proof colors, 466
 blade curvature with Lens Blur filter option, 379
 blend modes, 09with adjustment layers, 162Color Overlay style with, 314for Drop Shadow style, 308Fill blending mode, 211with filter effects, 381for Inner Shadow style, 320with layer masks, 267with layers, 135for Outer Glow style, 318with Pattern Overlays, 316for Stroke layer style, 315
 blend layers, Auto, 132-133bloating with Liquify, 360Blur filters. See also Lens Blur filter
 Box Blur filter, 172channel masks, softening effects of, 279Field blur filter, 376-377Gallery, 376-377Iris blur filter, 376-377in Quick Mask Mode, 283Shape Blur filter, 172-173Surface Blur filter, 172-173Tilt-Shift blur filter, 376-377
 Blur tool, 180BMP files, 427
 layers exported as, 138borders
 Auto Color command with, 213channel mask borders, moving, 280layer mask borders, creating, 267
 paths, creating shapes as, 302boundaries, proportional transform, 102bounding boxes, 267
 clipping paths and, 298in Print dialog box with preview, 416-417
 Box Blur filter, 172Bridge, 1, 4
 adjustments, images, 556automating, tasks, 557camera raw, 548-551closing documents and opening, 31exploring, 545images, working with, 552-553Mini Bridge, 558opening files with, 16photos, getting, 547preferences, 554-555starting, 546with Adobe Creative Cloud, 2, 13, 473Web Photo Gallery, 553
 brightness. See also HSB (hue, saturation, brightness)
 with Lens Blur filter, 379Brightness/Contrast adjustment, 191,
 216-217Bristle brush tip
 adjusting, 238Brush font, 318Brush Pose, 234, 237brush strokes filters, 356
 in Quick Mask Mode, 283brush tips, 236
 cursor options, 66customized brush tips, creating, 239saving, 240
 brushes, 231. See also specific toolswith Color Replacement tool, 260Liquify tool option, 362in Quick Mask Mode, 282with Vanishing Point tool, 168
 Brush Options menu, 240Brush panel, 234
 Bristle brush tip, adjusting, 238Brush tip, adjusting, 237pre-defined sets in, 236
 Brush Presets panel, 234modifying, 235
 built-in scripts, 411
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 Build-up, brush, 234, 237Bulge style of warped text, 336Burn tool, 183
 Ccache preferences, 57
 setting levels, 74calibrating colors. See color managementcalligraphy lettering, Pencil tool for, 243Camera Data 1 and 2, 430Camera Raw
 dialog box, 18-19, 548-551introduction, plug-in, 544filter, using, 368preferences in Bridge, 548preferences in Photoshop, 61Radial filter, 370, 550-551Spot Removal filter, 371, 550-551Upright filter, 369, 550-551
 canvas size, 22-23center justification, 331chain button with layer masks, 263channel masks, 261. See also Quick
 Mask Modecombining, 281deleting, 278-279filter effects, controlling, 386-387Gaussian Blur filter with, 279, 281loading, 278-279modifying options, 274moving masks between documents, 280from native color channels, 276-277pre-existing channels, options, 274saving, 278-279from scratch, 273from selections, 275showing/hiding, 273softening effects of, 279working with, 272
 Channel Mixer adjustment, 221channels, 191. See also channel masks
 Channel Mixer adjustment, 2218-bit channels, 192-193Spot color channels, 212
 Channels panel. See also channel masksselections, creating, 100working with, 194
 Character panel, 78-79, 327showing/hiding, 331
 Character panelworking with, 332-333
 Character Styles panelcreating styles, 338-339
 Chisel Hard Technique for bevel, 310chiseled text
 creating, 320with type mask, 350-351
 choke value for Inner Glow style, 321chromatic aberration, 170circles with Standard Shape tool, 246, 248-
 249clipart for Web, preparing, 434-435clipboard
 with Pattern Maker filter, 382preferences for, 59
 clipping. See also pathsmasks, creating, 117
 Clone Stamp tool, 181, 519Clone Source panel, 182, 184, 186, 519closing documents, 31CMYK (cyan, magenta, yellow, black) color,
 13, 47, 195. See also color manage-ment; out-of-gamut
 Color Slider, 206converting images to, 197Multi-Channel color mode, converting
 images to, 204patterns, generation of, 383press, preparing images for, 438-439RGB (red, green, blue) color and, 195,
 468soft-proof colors, setting up, 466-467Spectrums or Ramps, 207
 Color Balance command, 191, 216-217Color Dynamics, 234, 237color handling, printing, 420-421 Color Intensity with Match Color
 adjustment, 230color lookup table (CLUT), 200-201color management, 463-481. See also ICC
 Profile; out-of-gamut; rendering intentassigning profiles to document, 475converting color space to profile,
 476-477defaults, 472-473hardware, calibrating with, 465
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 monitors, calibrating, 464Print dialog, options, 420-421, 470-471RGB to CMYK, changing from, 468soft-proof colors, setting up, 466-467software, calibrating with, 465working with, 472-473
 Color Management, printing, 420-421color markers, creating, 46color modes, 13, 195
 bitmap color modes, 199changing, 195Replace Color command, 205selecting, 13
 Color Overlay, 305applying, 314
 Color panel, 206-207for PNG-8 documents, 494
 Color Picker, 58-59selecting colors from, 206-207, 232-233text color, changing, 329
 Color Replacement tool, 260color sliders, 206
 preferences for, 59Color Sampler Tool, 46, 233Color Swatch button, 331colors, 191. See also channels; CMYK (cyan,
 magenta, yellow, black) color; colormanagement; Info panel; RGB (red,green, blue) color; spot colors; tonal values; unified color table
 Auto Color command, 213Auto Contrast command, 213Auto levels command, 214Background colors, 232-233Background Eraser tool, 254-255
 of brush tips, 239Black & White adjustment, 229Channel Mixer adjustment, 221clipart for Web, preparing, 434Color Balance adjustment, 216-217Color Range, 93, 478-479Color Replacement tool, 260Curves adjustment, 216deleting on Swatches panel, 208Desaturate command, 218for Drop Shadow style, 308Equalize command, 224Eraser tools with, 254-255
 Exposure adjustment, 215fill colors, changing, 346Fill command, 210-211Foreground colors, 232-233for GIF documents, 492Gradient Map adjustment, 222Grid options, 70-71Guides option, 70-71for Inner Glow style, 320Invert command for, 224levels adjustment, 214Macintosh, printing in, 422-423Match Color adjustment, 230Navigator panel view box color, 36of notes, 45for Outer Glow style, 318Photo Filter option, 223, 380for PNG-8 documents, 494Posterize adjustment for, 225in Quick Mask Mode, 283Replace Color command, 205selection by color range, 93Selective Color adjustment, 220skin tones, detect faces, 93Slice option, 70-71Stroke command, 210Swatches panel, 208-209text color, changing, 329for transparency grid, 67
 Color Range, 93, 478-479ColorSync, 464, 476
 workflow, setting, 472color settings, 472
 with Creative Cloud, 473columns and rows
 ruler options, 69Single Row/Column Marquee tools, 86
 combine layers, Auto, 132-133combining channel masks, 281commands. See also specific commands
 built-in or custom scripts, 411compression. See file compressioncomps, layer, 137concavity with Line tool, 245conditional action, 384, 406Conditional Mode Change command, 446Contact Sheet, creating, 452-453
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 Content-Aware fill, 108-109with Patch tool, 110
 Content-Aware move and extend, 111Content-Aware Move tool, 10, 111
 Content-Aware scaling, 107contours
 for Bevel and Emboss style, 311for Outer Glow style, 319working with, 312
 Convert Point tool, 297Convert To Mask button, 272Convert To Profile command, 476copies
 different file formats, save as, 429file copies, saving, 28printing, 416, 422, 424
 copying. See also actions; layersdo not copy watermarks, 389History states, 142, 147selection, 99, 127with Vanishing Point tool, 168-169
 copyrights, watermarks protecting, 355, 388-389, 430-431
 contoursfor Drop Shadow style, 309for Inner Glow style, 321
 Count tool, 52-53crawling marquee, 286Create New Action button, Actions panel,
 394-395, 396Create New Channel button, 272Create New Layer button, 267
 duplicating layers with, 128Create New Set button, Actions panel, 395Create Plane tool, 168Crop and Straighten Photos command,
 447Crop command, 102crop marks, printing, 418cropping selections, 104-106
 two images at the same time, 104Crop Tool, 104-105
 Perspective Crop Tool, 106CSS (Cascading Style Sheets)
 copying from layers, 139importing color swatch from, 208-209
 cursorspainting cursor options, 66
 preferences, 66Curves adjustment, 191, 216
 with channel masks, 277custom preset document, creating, 12Custom Shapes tool, 247-252
 creating custom shapes, 251saving shape sets, 252
 customizing, 55. See also layer stylesbrush tips, 239color settings, 472-473Swatches panels, 209user interface, 62-63, 80-81workspace, 78-79
 cutout filter effect, 390
 Ddata driven graphics, 508DCS files, 427
 press, preparing images for, 438-439defaults for panels, 7-9default type styles, 341Delete button, Actions panel, 395deleting. See also layers
 actions, commands from, 401adjustment layers, 161anchor points in paths, 292-293with Bridge, 552-553channel masks, 278-279customized workspace, 78-79linked layers, 129notes, 45panels, 7-9pixels, 44presets, items in, 77ruler guides, 49Swatches panel, colors on, 208text, 329
 density option, 423, 390depth values
 for Bevel and Emboss style, 310Lens Blur filter option, 379for texture, 313
 Desaturate command, 218Despeckle filter, 174destination for droplets, 413DICOM files, 427Difference Blending Mode, 162
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 diffuse glow filter effect, 391digital cameras
 calibrating, 465importing raw data from, 18-19noise from, 167
 digital watermarks, embedding, 355, 388-389
 Direct Selection tool, 295curve of segment line, changing, 297type path, reshaping, 354
 direction for Bevel and Emboss style, 310Display preferences. See also interfacedistance values
 for Drop Shadow style, 309Lens Blur filter option, 379
 distortion, 356with Free Transform command, 102for layer mask borders, 267Lens Correction filter and, 170-171in Quick Mask Mode, 283Transform command selection, 103
 distribution option with Add Noise filter,166
 ditheringclipart for Web, preparing, 434for GIF documents, 493for gradients, 257for Indexed color mode, 200for PNG-8 documents, 495for WBMP documents, 469
 DNG filesinformation on, 551raw images saved as, 18-19, 548-551
 do not copy watermarks, 389Dock, painting engine in, 234docking, 6
 document windows, 42document dimensions, 30document window, 6
 moving images in, 41Vanishing point tool, working with, 168-
 169documents. See also layers; new docu-
 mentsall documents, closing, 31backgrounds, converting multi-layered
 documents into, 123closing, 31
 custom preset document, creating, 12dragging layer thumbnails into
 documents, 44inserting, images, 17
 file information into, 430-431New Document Preset Resolutions,
 68-69multiple, arrange, 42organizing documents, 429profiles, 30saving, 28-29sizes, 30
 Dodge tool, 183downloading
 DNG converters, 19layer styles, 324patches, 24-25updates, 24-25
 dragging layer thumbnails into documents,44
 Drawing tool, 231Drop Shadow, 306
 creating, 308-309with layer masks, 265modifying, 308-309
 droplets, 393creating, 412-413naming options, 413using, 414
 dry brush filter effect, 390DSC 2.0 color plates, 212Dual Brush, 234, 237Duotone color mode, 195
 converting images to, 203duplicating. See copyingDust and Scratches filter, 166dynamic range, 192-193. See also High
 Dynamic Range (HDR) images
 EEast Asian
 language options, 329Edit Plane tool, 290editing
 animated GIFs, 499inserted documents, 17nondestructively, 21selections, 98
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 8-bit channels, 192-193Exposure adjustment with, 215
 ellipsesfor layer mask borders, 267with Standard Shape tool, 246, 248-249
 Elliptical Marquee tool, 85Embed Color Profile, Macintosh, 429embedding
 ICC color profiles, 474for JPEG images, 491for PNG images, 494-496proof profile information, 29
 Emboss style. See Bevel and Emboss styleemulating color systems, 472Enable GPU (Graphics Processing Unit), 74-
 75, 530-531encoding images for press, 439EPS files, 427
 inserting images in, 17metadata information, adding, 431text saved as, 337
 Equalize command, 224Eraser tools, 231, 254-255
 Background Eraser tool, 254-255basic Eraser tool, 254with Foreground and Background
 colors, 232to History brush, 153Magic Eraser tool, 256
 exact colors for Indexed color mode, 200Exclusion Blending Mode, 162EXIF profile tag, ignoring, 61exiting Photoshop, 32Export Layers To Files command, 138exporting. See importing and exportingexposure
 controlling, 30Exposure adjustment, 215
 Extension Manager, 562Extract, 355eyedroppers, 93
 for Background colors, 232-233for Foreground colors, 232-233with Save For Web command, 486for 3D models, 539with Vanishing Point tool, 169
 FF-Stop information, 430Face detection, 93fades, 355
 with Match Color adjustment, 230with Smart Sharpen filter, 179working with, 384
 Feather optionwith layer masks, 266for out-of-gamut colors, 479
 Field blur filter, 376-377File Compatibility options, 28-29, 61file compression
 lossy/lossless compression, 432understanding, 432
 file extensionsfor droplets, 413lowercase, saving as, 29
 file formats. See also specific typesdifferent file formats, saving documents
 with, 428-429list of, 427understanding types of, 427
 File Handling preferences, 55, 60-61files. See also droplets; importing
 and exporting3D, 530-542actions as files, saving, 410File Handling preferences, 60-61
 Fill command, 210-211Content-Aware fill, 108-109for paths, 285with paths, 300
 fillscolors, changing, 346Layers panel option, 114with Paint Bucket tool, 253for Stroke layer style, 315
 Filter Controls, Image Gallery dialog box,356
 Filter Gallery, 356-357multiple filters, applying, 359preferences, 72
 Filter Selection, Image Gallery dialog box,356
 filter layers, 114, 124, 125isolate layers, 126
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 filters, 355-392. See also specific typeson adjustment layer masks, 165Blur Gallery, 376-377categories of, 356channel masks controlling effects,
 386-387Fade command with, 384gradient masks with, 386-387for layer mask borders, 267Lens Correction filter, 170-171Lighting Effects filter, 375multiple filters, applying, 359Oil Paint filter, 374order for applying, 359Photo Filters, 223, 380in Quick Mask Mode, 283selections, controlling filters with, 385shortcut for reapplying, 357various filter effects, 390-392watermarks, embedding, 355, 388-389Adaptive Wide Angle filter, 372-373
 Find and Replace, 327, 343with Bridge, 552-553
 Find Edges filter, 384FireWire, Scratch Disks with, 57Fish style of warped text, 336Fisheye style of warped text, 336Fit Image command, 462Fixed Aspect Ratio
 with Elliptical Marquee tool, 85with Rectangular Marquee tool, 84
 Flag style of warped text, 336Flash. See SWF filesflow
 for Airbrush tool, 241for Paintbrush tool, 241
 fontsCharacter panel selections, 332-333missing fonts, replacing, 329neon effects for, 318of notes, 45preferences, 58preview size on menu, changing, 330types of, 331Type preferences for, 76Type tool, working with, 330
 foregrounds, 232-233default and switching of, 233
 with Paint Bucket tool, 253freeform bounding box, 17Free Transform command, 102Freeform Pen tool, 290-291FreeHand, moving shapes to, 251freezing with Liquify, 361fresco filter effect, 390Full Screen Mode, 37Fuzziness slider, 93
 Ggamut. See also out-of-gamut
 preferences, 67Gamut Warning, 197, 416, 482
 mask, 67Gaussian Blur filter, 174
 on adjustment masks, 165with channel masks, 279, 281with layer masks, 266, 267Smart Sharpen filter with, 178
 General preferences, setting, 58-59geometry
 with Custom Shapes tool, 247with Line tool, 245paths, complexity of, 290with Standard Shape tool, 246
 GIF files, 415, 488. See also animated GIFscreating, 522-523clipart for Web, preparing, 434-435compression of, 432metadata information, adding, 431opening images, 16optimizing GIF documents, 492-493Save For Web command with, 484saving documents as, 28for Web images, 483
 glass filter effect, 391Global Light option
 for Bevel and Emboss style, 311with Drop Shadow style, 308
 Gloss Contours for Bevel and Emboss style, 311
 glowing edges filter effect, 391Gradient Map adjustment, 222Gradient Overlay, 305Gradient tool, 11
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 gradients, 231creating, 257customized gradients, 258-259with filters, 386-387for Inner Glow style, 321for Outer Glow style, 319pre-defined gradients, adding, 257with Stroke layer style, 315
 Graphics Processing Unit (GPU)GPU Sniffer, 75preferences, 74-75, 530-531supporting, 75
 grain filter effect, 392graphic pen filter effect, 392gray. See also Grayscale color mode
 with layer masks, 262, 264Grayscale color mode, 13, 195
 Channel Mixer adjustment with, 221Color Slider, 206converting images to, 198Duotone color mode and, 203patterns, generation of, 383Spectrums or Ramps, 207working with, 198
 grid size, 70-71transparency grid size, 67
 groupsadjustment layers, grouping, 160nested layer group, creating, 119
 Guides, Grids & Slices options, 70-71guides
 ruler guides, 48-49custom, 45 degree angles, 86
 HH.276, 560-561halftone screens for press images, 439Hand tool
 with Lens Correction filter, 170with Liquify, 361monitor, fitting image to, 40moving images, document window, 41with Save For Web command, 486with Vanishing Point tool, 169
 Hard Mix Blending Mode, 162hard proofs, printing, 420-421, 470-471hardware color calibration, 465
 HDV Anamorphic Pixel Aspect Ratio, 15Healing Brush tool, 184
 with Reduce Noise filter, 167, 184height values
 Fit Image command, 462with Pattern Maker filter, 383print size option, 417
 Help menuupdates, checking for, 25using, 26-27
 hiding. See showing/hidingHiDPI, 2, 38-39, 335High Dynamic Range (HDR) images,
 192-193, 226-227Exposure adjustment with, 215Merge images to, 458-459Merge image to, in Bridge, 455
 highlightsfor Bevel and Emboss style, 311with Dodge and Burn tools, 183Shadow/Highlight adjustment, 228tonal range, controlling, 188-189
 Histogram panel, 190for levels, 189
 History brush, 141combining with History states, 150correcting mistakes with, 150Eraser tool to, 153layers with, 153snapshots, working with, 151
 History panel, 141-153. See also snapshotslinear history, 141, 144
 resetting to, 154multiple undo commands, 142non-linear state of, 141, 144-145purging RAM, 154saving RAM, 147setting options in, 142-143
 History states, 56, 74controlling, 154duplicating, 142, 147History brush combined with, 150number, setting, 142purging, 145, 154reviewing text file, 149saving, 148
 Horizontal Type Mask tool, 347Hot keys. See shortcut keys
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 HSB (hue, saturation, brightness)Brightness/Contrast adjustment, 191, 216Color Slider, 206Hue/Saturation adjustment, 218opacity of, 162Replace Color command and, 205
 HTML (Hypertext Markup Language) filescopying CSS from layers, 139generating, 489importing color swatch from, 208-209
 hue. See HSB (hue, saturation, brightness)Hue/Saturation adjustment, 218
 for out-of-gamut colors, 478-479hyphenation
 Character panel selections, 333Paragraph panel selections, 334
 IICC Profile
 embedding ICC color profiles, 474information, embedding, 29for JPEG images, 491for PNG images, 494-496Windows, 429
 Illustrator, 234inserting images in, 17paths, exporting, 285, 303-304Pen tools in, 289scripts, using, 411shapes to Illustrator, moving, 251
 image cache, 55preferences, 57
 image compression, 415Image Gallery dialog box, 356Image menu, Adjustments option, 155Image Preview, Image Gallery dialog box,
 356Image Processor, 460-461image pyramid, saving, 441images, with bit depth (8, 30, and 32),
 192-193importing and exporting. See also paths;
 SWF filesdigital camera, raw data from, 18-19layers to files, exporting, 138shapes to vector, exporting, 251video, 526-527
 Zoomify, 510inches as measurement system, 33Include All Subfolders command, 412indents
 Paragraph panel selections, 334with Standard Shape tool, 246
 InDesign, 76adjustment layers, opening, 156clipping paths in, 285EPS documents, type information in, 337
 indexed color mode, 195converting image to, 200-201
 Inflate style of warped text, 336Info panel, 46
 changing measurement of colors in, 47color markers, creating, 46displaying information in, 47specific size object, creating, 46
 ink density. See densityinkjet printers
 getting the best results for, 440-441resolution, understanding, 433
 Inner Glow style, 320-321Inner Shadow style, 318-319Insert Menu command with actions, 407inserting images in documents, 17installing Photoshop, 2-3intellectual property, protecting, 355,
 388-389interface
 preferences, 62-63interlacing
 for GIF images, 493for PNG-8 documents, 495for PNG-24 documents, 496
 Internet. See also Web design; Web images; Web sites
 help on, 26-27saving files for, 28updates, checking for, 24
 interpolation, 22-23, 58, 286press, images for, 439
 invertingcommand, 224Lens Blur filter option, 379textures, 313
 IPTC Contract, 430
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 Iris blur filter, 376-377isolate layers, 126
 filter layers, 114, 124, 125
 JJavaScript, 411jitter
 for Inner Glow style, 321Liquify tool option, 362for Outer Glow style, 319
 JPEG files, 415, 427, 488compression of, 432JPEG 2100 format,427, 437JPEG Stereo, 427layers exported as, 138metadata information, adding, 431opening images, 16optimizing JPEG documents, 490-491photographs for Web, preparing, 436-437printers, preparing images for, 441raw images saved as, 18Save For Web command with, 484, 488saving documents as, 28transparency, support for, 67for Web images, 483
 justificationParagraph panel selections, 334of text, 329, 331
 Kkerning, 332keyboard. See also shortcut keys
 paths, moving, 294Kuler panel, 207
 LLab color mode, 13, 195
 Color Slider, 206converting image to, 202patterns, generation of, 383
 landscape orientation, 416-417language options, 329large files, saving, 22, 61laser printers, preparing images for,
 440-441Lasso Marquee tool, 87
 Lasso tools. See also specific toolsLasso Marquee tool, 87for layer mask borders, 267Magnetic Lasso tool, 88-89Polygonal Lasso tool, 87-90
 launching Photoshop, 4-5Layer Comps panel, 137layer filters, 114, 124, 125layer masks, 114, 261
 borders, creating, 267creating, 263modify, 269Paint tools with, 264role of, 262selections generating, 265soft transparency, generating, 266type masks, combining with, 352-353as white, 264
 layer shapes, 246, 248-250Layer Style dialog box, 307
 customized styles with, 322-323layer styles, 305-326. See also specific
 stylesadding, 307combining layer style elements, 322customized styles
 with Layer Style dialog box, 322-323with Styles panel, 324-325
 to masked images, 265modifying existing layer style, 307moving existing layer styles, 326names for, 323, 325saving customized styles, 324sharing, 325showing/hiding, 307single layer styles, moving, 326understanding, 306
 layers, 113-140. See also adjustment layers;backgrounds; layer masks; layerstyles; linked layers; opacity; Typetool
 active document, adding layers to, 116blending modes, 135comps, creating, 137copying, 99, 128
 elements in layers, 121deleting, 114, 129
 linked layers, 129
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 designation of, 115different file formats, saving documents
 as, 429dragging layer thumbnails into
 documents, 44Eraser tools with layered documents,
 254exporting as files, 138filtering, 114, 124, 125, 126History brush, multiple layers with, 153isolating, 126locking, 124Magic Eraser tool with, 256Merge options with, 130moving, 116
 documents, layers between, 44, 127names for, 124nested layer group, creating, 119new layers, creating, 116-117opacity, 136pasting, 99properties, changing, 124saving, 28selecting layer options, 117selecting methods, 118selections from layers, creating, 120-121showing/hiding, 124Smart Objects, converting, 21stacking order, changing, 124two open documents, moving layers
 between, 44updating layer comps, 137
 Layers panel, 114. See also layerscontrolling image information with, 124setting options, 140thumbnail size, changing, 140tonal range, controlling, 188-189
 leading Character panel selection, 333left justification, 331length with Line tool, 245Lens Blur filter
 brightness with, 169, 379Smart Sharpen filter with, 178working with, 378-379
 Lens Correction automation, 456-457Camera Raw, Upright filter, 369
 filter, 170-171Levels adjustment, 188-189
 for actions, 398with channel masks, 277with type masks, 349working with, 214
 libraries, Preset Manager for, 77Lighting Effects filter, 375lighting, adjusting, 3D, 541Line tool, 245
 45 and 90 degree angles, 245linear history. See History panellines. See straight linesLink Layers option, Layers panel option, 114linked layers, 124
 with composite adjustment layers, 159creating, 124, 131deleting, 129with Pattern Overlays, 317textures, linking, 313unlinking, 131
 Liquify, 355mask options, 364meshes
 applying, 367creating, 366modifying loaded meshes, 367Show Mesh option, 365, 366
 modifying images with, 360options, working with, 362-363saving meshes, 367Show Mesh option, 365, 366Smart Object, 362view options, 365
 Load Mesh button, 366loading
 channel masks, 278-279meshes, 366
 localized color cluster, 93, 205locking layers, 124
 Layers panel option, 114locking ruler guides, 49lossless compression, 432
 printers, preparing images for, 440-441lossy compression, 432
 for GIF images, 493
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 luminositywith Match Color adjustment, 230Photo Filter option, 380
 LZW filescompression of, 432printers, preparing images for, 441
 MMacintosh
 color calibrator in, 464Embed Color Profile option, 429Print Settings in, 422-423, 425printers, preparing images for, 441printing documents in, 422-423
 Magic Eraser tool, 256Magic Wand tool, 92
 channel masks, creating, 275Magnetic Lasso tool, 88-89
 with paths, 291Make Work Path button, 287marching ant marquee, 284margins
 in Macintosh Page Print Settings, 425Paragraph panel selections, 334in Windows, 425
 Marquee tools, 83. See also EllipticalMarquee tool; Rectangular Marqueetool
 Lasso Marquee tool, 87Single Row/Column Marquee tools, 86type masks, creating, 347with Vanishing Point tool, 168
 masks, 114. See also channel masks; layermasks; Quick Mask Mode; selections;Type tool
 with adjustment layers, 164-165clipping masks, creating, 117Liquify mask options, 364Minimum and Maximum filters, 270-271Standard Mask Mode, 282Match color adjustments, 191, 230modify, 269vector masks, 262, 268, 269
 Mask Edge button, 266match prints, printing, 470-471matte option
 clipart for Web, preparing, 434
 for GIF documents, 493for indexed color mode, 200for JPEG images, 491photographs for Web, preparing, 436for PNG-8 documents, 495for PNG-24 documents, 496for Web design, 485
 maximize compatibility, saving, 28-29, 61Maximum filter, 270-271measurements
 Rulers, 48-49system for, 33
 Measurement scale, 50-51, 168Measurement Log panel
 counting, 52-53taking measurements, 50-51
 memory. See also RAM (random access memory)
 100% Memory Usage option, 75preferences, setting, 74-75
 Memory & Image Cache preferences, 74-75menus
 color preferences for, 59customizing, 80-81original settings, restoring, 80
 Mercury Graphics engin 9MGE), 75Merge Down option, 130Merge Image to HDR Pro, 226-227, 455,
 458-459Merge Visible option, 123, 130merging. See also adjustment layers
 Merge Down option, 130Merge Visible option, 123, 130Photomerge, 454-455
 meshes. See Liquifymetadata, 13, 552
 adding to files, 430-431with Bridge, 552-553
 midtoneswith Dodge and Burn tools, 183Shadow/Highlight adjustment for, 228tonal range, controlling, 188-189
 Mini Bridge, 558Minimum filter, 270-271mirroring with Liquify, 361missing fonts, replacing, 329Mixer Brush tool, 242
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 modefor Airbrush tool, 241color, 13, 195Conditional Mode Change command,
 446with Custom Shapes tool, 247for gradients, 257with Line tool, 245for Paint Bucket tool, 253for Paintbrush tool, 241for Pencil tool, 243
 monitors. See also color managementautomatically fitting image to, 40calibrating, 465resolution, understanding, 433selecting areas for, 84soft-proof colors, setting up, 466-467
 monochromatic optionwith Add Noise filter, 166with Lens Blur filter, 379
 mosaic tiles filter effect, 392Motion Blur filter
 Add Noise filter with, 166Smart Sharpen filter with, 178
 mouse movements in actions, 407Move Grid tool, 170Move tool, 11
 with Vanishing Point tool, 168moving. See also layers; paths
 adjustment layers, 157anchor points in paths, 292with Bridge, 552-553channel masks between documents, 280Document window, images in, 41layer styles, 326with Vanishing Point tool, 168-169
 Multi-Channel color mode, 195, 204multi-layered documents into backgrounds,
 converting, 123Multi-Picture Format files, 427Multiply blending mode
 with layers, 135, 162with Pattern Overlays, 316
 Nnames. See also renaming
 for action sets, 408
 for custom preset document, 12of data driven graphics, 526droplets, naming options for, 413for gradients, 258for layer styles, 323, 325for layers, 124
 native color channels, channel masks from,276-277
 native formats, 492Navigator panel. See also zooming
 area of view, changing, 35color of view box, changing, 36shortcuts, 34size of view, changing, 34thumbnails, sizing and zooming, 35-36
 Nearest Neighbor method, 22, 58neon effects, 318nested layer group, creating, 119New Document Preset Resolutions, 68-69new documents
 creating, 12preset resolutions, 68-69with presets, 14
 New Layer dialog box, 117New Layer Effect button, 359noise
 Add Noise filter, 166with brush tips, 237for Drop Shadow style, 309for Inner Glow style, 320for Outer Glow style, 318Reduce Noise filter, 167
 nondestructive editing, 21non-linear state of History panel, 141,
 144-145non-squared pixels, 15Notepad (Win), 411note paper filter effect, 391notes, 45
 different file formats, save as, 429saving, 28, 45
 Ooffset with Pattern Maker filter, 383Oil Paint filter, 374on-image controls, 229onion skinning, 524-525

Page 68
                        

592
 opacity, 67with adjustment layers, 162-163for Airbrush tool, 241with Art History brush, 152for Bevel and Emboss style, 311for Color Overlay style, 314with Custom Shapes tool, 247for Drop Shadow style, 308of gradients, 259for Inner Glow style, 320Layers panel option, 114Liquify view option, 365for Outer Glow style, 318for Paintbrush tool, 241with Pattern Overlays, 316for Pencil tool, 243setting, 117, 136for Stroke layer style, 315
 OpenCL, 74-75, 530-531OpenEXR files, 427OpenGL, 3, 38, 40, 74-75, 530OpenType font
 changing font attributes, 333defining, 330-331
 opening images, 16Optimize To File Size option, 487optimizing
 image to file size, 487Photoshop, 56-57
 Options bar, 6, 11organizing documents, 429outline font, 331output options, printing, 416-419out-of-gamut, 67, 197
 command, test, 482Hue/Saturation Adjustment for, 478-479Sponge tool, working with, 480-481
 Out of Scratch Disk Space error, 57Outer Glow style, 306
 working with, 318-319output options, setting
 setting, 504-505saving, 504-505
 Overlay blending mode with Pattern Overlays, 316
 Override Action "Open" commands, 412
 PPage Setup, in Print Settings, 425Paint Brush tool, 83Paint Bucket tool, 11, 253Paint tools, 10, 231
 with layer masks, 264Paintbrush, 241
 with layer masks, 264as Stroke tool, 301
 painting. See also gradientsadjustment layers, opening, 156on adjustment masks, 164cursor options, 663D models, 539
 painting engine. See Brush panelpanel knife filter effect, 390panels, 6. See also specific types
 adding panels, 7-9customizing, 78-79preferences for, 59showing/hiding, 7-9, 37subtracting panels, 7-9working with, 7-9workspaces, 78-79
 panoramic photographscorrecting with Adaptive Wide Angle
 Filter, 472-473creating, in Photoshop, 454-455creating, in Bridge, 455
 Pantone Color Matching System, 463paper options, 425, 423Paragraph panel, 78-79
 showing/hiding, 331working with, 333, 334
 Paragraph Styles panelcreating styles, 338-339Paste, preferences for resizing, 59
 pasting, selection, 99, 127Paste in Place, Paste Into, 99, 127
 Patch tool, 184-185with Content-Aware Fill, 110with Reduce Noise filter, 167
 patches, checking for, 24-25Path Selection tool, 294
 type path, reshaping, 354paths, 304. See alsoType tool
 anchor points
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 adding, 292converting, curved to straight points,
 straight to curved points, 297deleting, 292-293direction lines, modifying, 296with Magnetic option of Freeform Pen
 tool, 291modifying, 294-295moving, 292
 clipping paths, 285working with, 298-299
 complexity of path, controlling, 290curved to straight points, converting, 297deleting anchor points, 292-293direction lines, modifying, 296Fill command with, 285, 300Freeform Pen tool, 290-291
 Magnetic option, using, 291Illustrator, exporting paths to, 303-304keyboard, moving path with, 294Magnetic option of Freeform Pen tool,
 using, 291moving
 anchor points, 292keyboard, moving path with, 294
 Paths To Illustrator command, exportingpaths with, 304
 Pen tools with, 285, 288-289Save As, exporting paths with, 303selections into paths, converting, 287shapes as paths, creating, 302straight to curved points, converting, 297Stroke command with, 285, 301
 Paths panel, 285Paths To Illustrator command, 304Pattern Maker, 355, 382-383Pattern Overlays, 305
 repositioning, 317working with, 316-317
 patternswith Paint Bucket tool, 253for Stroke layer style, 315for texture, 313
 pauses in actions, 402PBM files, 427PCX files, 427PDAs (personal digital assistants), 196
 RGB (red, green, blue) color with, 468
 PDF files, 427, 443creating, saving, 450-451format, 451inserting images in, 17layers exported as, 138metadata information, adding, 431multi-page PDFs to PSDs, converting,
 448-449PSD file, converting to, 448-449types of, 450
 PDF presentations, 427, 443creating, 450-451
 PDF presetscreating, working, 451
 Pen toolsin Illustrator, 289with paths, 285, 288-289
 Pencil tool, 243Auto Erase and, 244for calligraphy lettering, 243
 perceptual rendering intent, 469Performance, 56-57, 74-75, 530-531Perspection web site, 11Perspective Crop Tool, 106perspective of Transform command
 selection, 103Photo Filters, 223, 380photographic manipulation, 181photographic restoration, 166photographs for Web, preparing, 436-437Photomerge, 454-455Photoshop, 32-bit or 64-bit, 3, 5Photoshop Extended, 529picas as measurement system, 33PICT files, 427Pincushion distortion, 170-171Pixar files, 427Pixel Aspect Ratio Correction, 15pixelization, 13pixels, 13. See also adjustment layers;
 raster dataAdd Noise filter, working with, 166of data driven graphics, 526of data sets, 509Equalize command, 224with Eraser tool, 232excess pixels, deleting, 44Histogram panel, information in, 190
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 pixels (continued)image interpolation, 58large files, saving, 22Magic Eraser tool with, 256as measurement system, 33non-squared pixels, 15resolution, understanding, 433with RGB (red, green, blue) color, 468Smart Sharpen filter, 178-179Unsharp Mask filter, 175
 Place commandinserting images in documents with, 17preferences for resizing, 59
 placeholder text, inserting, 329plastic wrap filter effect, 392Play button, Actions panel, 395play options, 412playback of command, controlling, 399Plug-ins, 72
 preferences, 72PNG-8 files
 information on, 432optimizing PNG-8 documents, 494-495saving for the Web, 484-485
 PNG-24 filesinformation on, 432optimizing PNG-24 documents, 496saving for the Web, 484-485
 PNG files, 427clipart for Web, preparing, 434-435compression of, 432layers exported as, 138metadata information, adding, 431opening images, 16photographs for Web, preparing, 436-437Save For Web command with, 484-485,
 488saving documents as, 28for Web images, 483
 Polygonal Lasso tool, 87-90polygons
 Polygonal Lasso tool, 87-90with Standard Shape tool, 246, 248-249
 portrait orientation, 416-417position for Stroke layer style, 315Posterize adjustment, 225PostScript type size, 48, 76precise cursor options, 66
 preferences, 55cursors preferences, 66File Compatibility options, 28-29, 61File Handling preferences, 60-61gamut preferences, 67General preferences, 58-59Guides, Grid & Slices preferences, 70-71interface preferences, 62-63Memory & Image Cache preferences,
 74-75Performance, 56-57, 74-75, 530-531Plug-ins preferences, 72resetting preferences, 59scratch disks preferences, 73Sync Settings preferences, 64-653D preferences, 530-531transparency preferences, 67Type preferences, 76Units & Rulers preferences, 68-69
 Preset Manager for libraries, 77presets
 new documents with, 14Preset Manager, 77saving items and, 77tools, 54
 press, preparing images for, 438-439previewing
 fonts, 76, 330-331Lens Blur filter option, 379non-squared pixels, 15press, images for, 439with Save For Web command, 486transparency settings, 67with Unsharp Mask filter, 175
 Print One Copy command, 426Print dialog box with preview, 416-419printers. See also Windows
 calibrating, 465converting color space to another
 profile, 476preparing images for, 440-441
 printingGamut Warning, 416hard proofs, 470-471larger images, 426Macintosh, documents in, 422-423one copy of document, 426output options, 416-419
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 Print dialog box with preview, 416-419Show Paper White, 416Windows, documents in, 422
 problems, reporting, 25progressive option
 for JPEG images, 491photographs for Web, preparing, 437
 proof profile information, embedding, 29Proof Setup, Windows, 429Protect Texture option, 237Protect Tones, 183, 480PSB files, 427
 opening images, 16PSD files, 427
 adjustment layers as, 156creating, 450-451
 as a presentation, 451large files, saving, 22layers exported as, 138metadata information, adding, 431multi-page PDFs to PSDs, converting,
 448-449opening images, 16PDF files, converting, 448-449preferences for saving, 61raw images saved as, 18
 puckering with Liquify, 360Puppet Warp tool, 112purging RAM, 145, 154pushing left with Liquify, 360
 QQuarkXpress, 298
 EPS documents, type information in, 337Quick Mask Mode, 284, 282
 filters in, 283options, working with, 283saving selections, 283
 Quick Selection tool, 91
 RRadial filter, Camera Raw, 370, 550-551Radiance files, 427radius option, 172-173, 175, 178-179, 246,
 379RAM (random access memory), 55. See
 also History panel; History states
 adjusting options, 74-75optimizing, 57purging RAM, 145, 154
 ramps, 207range values
 for Bevel and Emboss style, 312for Inner Glow style, 321for Outer Glow style, 319
 raster data, 433. See also Layers panelchange and, 415documents, 13interpolation and, 286saving, 428-429Smart Objects with, 21understanding raster images, 286
 Rasterize Type command, 344raw digital camera data, importing, 18-19RAW files, 18-19, 427
 large files, saving, 22reconstructing with Liquify, 360, 363Record button, Actions panel, 395recording actions, 397Rectangle tool for layer mask borders, 267rectangles
 with Rectangle tool, 246, 248-249, 267with Rounded Rectangle tool, 246, 248-
 249, 267Rectangular Marquee tool, 84
 with Pattern Maker filter, 382RedEye tool, 187Reduce Noise filter, 167
 with Healing Brush tool, 167, 184reduction
 for GIF documents, 492for PNG-8 documents, 494
 Refine Edgeselection, 94-95with Layer Masks, 266
 registration marks, printing, 418relative colorimetric rendering intent, 469remove option, Smart Sharpen filter, 178renaming
 with Bridge, 557presets, 77
 rendering intentfor hard proofs, 471for soft-proof colors, 466working with, 469
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 repeating Transform command selection,103
 Replace Color command, 205Resample Image option, 22resizing. See sizeresolution
 changing, 22-23selecting, 13understanding, 433
 retouching images, 181RGB (red, green, blue) color, 13, 47, 195.
 See also color management; out-of-gamut
 CMYK (cyan, magenta, yellow, black)color and, 195, 468
 Color Slider, 206converting image to, 196with 8-bit channels, 192-193Gamut Warning mask, 67Lab color mode for images, 202Multi-Channel color mode, converting
 images to, 204patterns, generation of, 383press, preparing images for, 438-439Spectrums or Ramps, 207
 right justification, 331Rise style of warped text, 336RLE (Run Length Encoding) scheme, 434Rotate View tool, 41rotating
 with Bridge, 552-553with Lens Blur filter, 379Smart Objects, 21Transform command selection, 103
 roughness of gradients, 259roundness, 270-271rows. See columns and rowsrulers, 48-49
 guides, working with, 48-49options for, 68-69switching between measurements, 68
 SSaturate and Desaturate command, 191saturation. See also HSB (hue,
 saturation, brightness)rendering intent, 469Saturate and Desaturate command, 191
 Save As command, 29paths exported with, 303with text, 331
 Save commands. understanding, 29
 Save For Web command, 484-485Save for Web dialog box, 487Save Mesh button, 366Save Optimized As command, 489saving. See also actions; layer styles
 Auto Save, 28-29, 60-61alpha channels, 28brush tips, 240channel masks, 278-279custom shape sets, 252documents, 28-29file formats, files with different, 428-429File Saving options, selecting, 60gradients, 258-259History states, 148image pyramid, 441inserting file information into docu-
 ments, 430-431large files, 22, 61layer styles, 324layers, 28Liquify meshes, 367maximize compatibility, saving, 28-29, 61notes, 28, 45preferences, 60-61presets, items as, 77Quick Mask selections, 283spot colors, 28Swatches panels, 209thumbnail data, 29understanding Save commands, 29for Web, 484-486
 scalingContent-Aware scaling, 107Character panel selections, 333with Pattern Overlays, 317in Print dialog box with preview, 419Smart Objects, 21for texture, 313Transform command selection, 103
 scannerscalibrating, 465noise from, 167
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 photographs for Web, preparing, 437Photoshop, scanning images into, 17
 Scattering, 234, 237Scratch Disks, 55, 57
 preferences, 73scratch sizes, 30
 Info panel displaying, 47Screen blending mode, 162
 with Pattern Overlays, 316Screen Mode for display, 37scripting
 Adobe ExtendScript Toolkit, 544, 559scripts, using, 411scroll wheel preferences, 59scrubby sliders, 11Scrubby Zoom, 40, 59SCT files, 427searching. See Find and ReplaceSelect menu options, 98selection marquees, hiding, 481selection masks, 100-101selections, 10, 83-105. See also specific
 toolsadding to, 96-97Brightness/Contrast adjustment with,
 217channel masks from, 275channels, creating with, 100by color range, 93cropping selections, 104-106filters, controlling, 385with Free Transform command, 102layers, 118layer masks, generation of, 265layer options, selecting, 117masks, 100-101, 165
 layer masks, generation of, 265modifying existing selection, 98paths, converting to, 287Quick Mask option, 284Quick Selection tool, 91Refine Edge, 94-95subtracting from, 96-97with Transform command, 102-103
 Selective Color adjustments, 191, 220sepia color, Fill blending with, 211sets. See actions
 Shadow Angles option with Drop Shadowstyle, 308
 Shadow/Highlight adjustment, 228shadows
 for Bevel and Emboss style, 311with Dodge and Burn tools, 183Shadow/Highlight adjustment, 228tonal range, controlling, 188-189
 Shake Reduction filter, 176-177Shape Blur filter, 172-173Shape Dynamics, 234, 237shape layers, 115
 arranging, 250creating, 248drawing option, 302work with, 248-249
 Shape Marquee tools, 11Shape tool, 231, 246-247
 shape layer, 248-249shapes
 creating, 248-249Custom Shapes tool, 247, 251-252editing and re-editing, 248-249Lens Blur filter option, 379paths, creating shapes as, 302on a shape layer, 246, 248-249with Standard Shape tool, 246Type tool, creating shape layers with,
 346sharing
 actions, 410layer styles, 325
 Sharpen tool, 180Shell Lower/Upper style of warped text, 336Shift key for tools, 11shortcut keys, 3, 4
 defining new, 82filters, reapplying, 357list of, xixwith Navigator panel, 34for tools, 11working with, 82zooming with, 39
 Show Paper White, 416showing/hiding
 channel masks, 273Character panel, 331layer styles, 307
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 showing/hiding (continued)layers, 124Navigator panel, 35panels, 7-9, 37Paragraph panel, 331selection marquees, 481toolbox, 37
 shutter speed information, 430sign in and sign out.
 Adobe Creative Cloud, 4-5, 25, 564Single Row/Column Marquee tools, 86size
 adjustment layers and, 155for Bevel and Emboss style, 310of CMYK document, 195of documents, 30for Drop Shadow style, 309image size, changing, 22-23Info panel, information in, 46, 47for Inner Glow style, 321for Outer Glow style, 319photographs for Web, preparing, 437preferences for resizing, 59for Stroke layer style, 315view size, changing, 34
 sketch filters, 356skewing Transform command selection, 103skin tones, detect faces, 93Slice Selection tool
 with Save For Web command, 486slicing images, 498-499
 arranging, 502-503distributing, 502-503HTML text, add, 506-507saving for the Web, 504-505setting output options, 504-505stacking, 502-503URL, add Web address, 506-507working with, 70-71, 500-501
 slide shows, 450-451sliders, changing text boxes to, 80Smart Filters
 Camera Raw, 368Creating, 358Smart Objects, from, 20-21Working with, 358
 Smart Guides, 134
 Smart Objects, 20-21apply Smart Filter, 358converting 3D layer to, 21inserting image as, 17-19preferences, 59
 Smart Sharpen filter, 178-179smoothness
 of gradients, 259with painting engine, Brush panel, 237
 Smudge tool, 180snapshots, 142
 creating, 146with History brush, 151
 softnessfor Bevel and Emboss style, 310channel masks, 279layer masks, soft transparency, 266soft-proof colors, setting up, 466-467
 software color calibration, 465sounds, preferences for, 59source option for Inner Glow style, 321spacing Paragraph panel selections, 334Spatter filter, 392
 for layer mask borders, 267specific size object, creating, 43spectrums, 207speed of Photoshop, adjusting, 74-75Spell Check, 327
 Character panel selections, 333checking, 342working with, 342
 Sponge tool, 183desaturating areas of image with, 218for out-of-gamut colors, 480-481
 spot colors, 212file formats, saving documents as, 429saving, 28
 Spot Healing Brush tool, 186Content-Aware fill, 108-109
 Spot Removal filter, Camera Raw, 371, 550-551
 spread valuesfor Drop Shadow style, 309for Outer Glow style, 319
 squareness, 270-271squares with Standard Shape tool, 246,
 248-249Squeeze style of warped text, 336
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 stacking images, 132stacking order of layers, 124stained glass filter effect, 392stamp filter effect, 391Stamp tool
 Clone Stamp tool, 181with Vanishing Point tool, 168
 Standard Mask Mode, 282Standard Pen tool with paths, 288Standard Screen Mode, 37Standard Shape tool, 246, 248-249
 Options bar, 11stars with Standard Shape tool, 246, 248-
 249Status bar, 30Stop button, Actions panel, 395straight lines
 drawing, using a brush, 236Line tool for, 245Pencil tool for, 244
 Straighten button, Ruler tool, 48-49Straighten tool, 170Stroke command, 210
 for paths, 285with paths, 301
 Stroke layer style, 315Stroke Path option, 301styles. See also layer styles
 for Art History brush, 152for Bevel and Emboss style, 310for default type, 341for type, 338-340
 Styles button for warping text, 336Styles panel, 305
 layer styles, creating, 324-325stylize filters, 356subfolders
 in Batch File Processing, 441Include All Subfolders command, 412
 subtracting from selection, 96-97Suppress Color Profile Warnings, 412Suppress File Open Options Dialogs, 412Surface Blur filter, 172-173SVG
 importing color swatch from, 208-209Swatches panel, 208-209
 customizing, 209loading or importing, 209
 saving, 209sync settings
 checking for, 564preferences, 64-65status bar, 30
 system requirements, 3
 Ttablecloth, 67Targa files, 427
 layers exported as, 138technique
 for Bevel and Emboss style, 310for Inner Glow style, 321for Outer Glow style, 319
 text, 33. See also anti-aliasing; notes; SpellCheck; Type tool; warping
 Asian text options, 76chiseled text, creating, 320of data sets, 509History state text files, reviewing, 149Rasterize Type command, 344workspace for, 78-79
 text boxes to sliders, changing, 80TextEdit (Mac), 411textures, 234, 237
 with Bevel and Emboss style, 312-313filters, 356Protect Texture option, 237
 thawing with Liquify, 36132-bit images, See also High Dynamic
 Range (HDR) images3D effects, Bevel and Emboss style for, 3103D model files
 adding to a 2D model, 532-535adding 3D objects, 538baking 3D objects, 538converting 3D layer to Smart Object, 21creating
 from a 2D image, 532-533from a grayscale image, 532-533instance 3D objects, 538from a multi-frame file (3D Volume),
 532-533from a shape preset, 534from type, 540
 deleting 3D objects, 538

Page 76
                        

600
 3D model files (continued)duplicating 3D objects, 538exporting a model, 542files, 530-542grouping objects, 538lighting, 541merging 3D layers, 538modifying a 3D model, 536-537painting, 539preferences, 530-531render a model, 542saving a file with a model, 5423D material eyedropper tool, 5393D material drop tool, 539workspace, viewing, 535
 threshold, 225with Lens Blur filter, 379with Surface Blur filter, 172-173with Unsharp Mask filter, 175
 thumbnails. See also Navigator panelwith Bridge, 13in Brush Presets panel, 235dragging layer thumbnails, 44file saving options, 60Layers panel thumbnail size, changing,
 140with Save For Web command, 486saving thumbnail data, 29
 TIFF files, 427adjustment layers as, 156large files, saving, 22layers exported as, 138metadata information, adding, 13, 431opening images, 16photographs for Web, preparing, 436-437preferences for saving, 61printers, preparing images for, 440-441raw images saved as, 18
 tile boundaries with Pattern Maker filter,383
 Tilt-Shift blur filter, 376-377tolerance
 for Art History brush, 152with Paint Bucket tool, 253for paths, 287
 tonal valuescontrolling, 188-189Histogram panel and, 190
 Invert command for, 224with Smart Sharpen filter, 179with Surface Blur filter, 172-173
 tool tip preferences, 59toolbox, 6
 showing/hiding, 37tools. See also specific tools
 multiple tools, accessing, 10working with, 10-11
 tracking Character panel selections, 333Traditional type size, 48transfer functions for press images, 439Transform command, 102-103
 with Vanishing Point tool, 168transparency. See also layer masks
 clipart for Web, preparing, 434clipping paths and, 298-299for GIF documents, 493for gradients, 257gray creating, 262, 264with History brush, 153for JPEG images, 491layer styles requiring, 306for PNG-8 documents, 495for PNG-24 documents, 496preferences, 67printer, preparing images for, 441soft transparency, generating, 266for Web design, 485
 TrueType fontdefining, 330-331
 turbulence with Liquify, 361turning on/off Smart Guides, 134tweening, 524-525twirling with Liquify, 360Twist style of warped text, 336Type 1 PostScript font
 defining, 330-331Type preferences, 76type styles
 for default type, 341for type, 338-340
 Type tool, 10, 327-354anti-aliasing, 335chiseled type, creating, 350-351editing type on path, 329extrude to 3D, 351, 540
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 fonts, working with, 330-331horizontal and vertical type, toggling
 between, 330layers, creating, 115, 346maskschiseled type, creating, 350-351creating type masks, 347layer masks, combining with, 352-353pixels, isolating, 348-349special effects, generating, 352-353moving type mask, 348options, working with, 330orientation, changing, 330paths, 328-329, 345
 text on path, creating, 354work paths, creating, 345
 placeholder text, inserting, 329preferences for, 76Rasterize Type command, 344resize type box, 331rotate type box, 331shape layers, creating, 346skew type box, 331special effects, generating, 352-353standard typing tools, 328-329Type menu, using, 328-331
 Uundos, 56. See also History panel
 multiple undo commands, performing,142
 unified color tablefor GIF images, 493for PNG-8 documents, 495
 units, 55. See also rulersoptions for, 68-69
 Unsharp Mask filter, 175Updater, 24-25updates
 checking for, 24-25from Internet, 24layer comps, updating, 137options, setting, 4for versions of Photoshop, 2
 Upright filter, Camera Raw, 369, 550-551user interface, customized, 62-63, 80-81
 VVanishing Point tool, 168-169variables, data, 508-509vector data
 interpolation and, 286Paths panel and, 285press, images for, 439saving, 428-429Smart Objects with, 20-21understanding vector images, 286
 vector masks, 262, 268, 269Vertical Type Mask tool, 347vibrance, 193, 219video, layers, 511
 adjustment layers, adding, 517audio, adding, 521cache, clearing, 154cloning, 519creating and modifying, 513-515exporting, 526-527Frames view, 522-525grouping, 516new documents with video presets, 14opening, formats, 512preview option, 14rasterize, creating still image, 528splitting, 518stacking order, 517text, adding, 517transitions, adding, 520Video Timeline view, 513-525
 views and viewing. See also Navigatorpanel
 Bird’s Eye view, 38-39with Bridge, 546, 552-553for Brush Presets panel, 235Liquify view options, 365Photoshop window, 6RGB color mode, 13, 195size of view, changing, 34two views, working on one image in, 43Zoom tool, changing view with, 38-39
 vignettesLens Correction filter, vignetting and, 170Radial filter, 370
 Vimeo, 560-561Visual Basic, 411
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 visibilityof data driven graphics, 509of data sets, 509
 WWarped Text button, 331warping
 with Liquify, 360Smart Objects, 20-21text, 331, 336-337Transform command selection, 103
 watermarksembedding, 355, 388-389restricted, 389
 Wave style of warped text, 336WBMP files
 optimizing WBMP documents, 497Save For Web command with, 484-485,
 488for Web images, 483
 Web Content panel, 505Web data variables, 508-509Web design, 483-510
 file formats, working with, 488-489optimizing image to file size, 487saving documents for, 484-486
 Web imagesclipart, preparing, 434-435Color Slider, 206lossy/lossless compression, 432photographs for Web, preparing, 436-437preparing, 415
 Web Photo Gallery, Bridge, 553Web snap
 for GIF documents, 492for PNG-8 documents, 494
 Wet Edges, 237width values
 Fit Image command, 462with Line tool, 245with Pattern Maker filter, 383print size option, 416
 Windowscolor calibrator in, 464ICC Profile, 429Microsoft ICM color management, 476Printer Settings in, 425
 printerspreparing images for, 440-441setting up, 425
 printing documents in, 424Proof Setup, 429
 workspace, using and customizing, 78-79WYSIWYG type, 76
 XXMP files, 13
 inserting file information into documents, 430-431
 XMP Software Development Kit, 431
 YYouTube, 560-561
 ZZIP files
 compression of, 432printers, preparing images for, 441
 Zoom tool, 33with Lens Correction filter, 170with Save For Web command, 486two views, working on one image in, 43with Vanishing Point tool, 169view of image, changing, 38-39Scrubby Zoom, 40, 59
 Zoomify, export, 510zooming, 6. See also Zoom tool
 area of view, changing, 35with Liquify, 361monitor, automatically fitting image to,
 40on multiple documents, 40with Navigator panel, 34-35106%, automatically zooming to, 40preferences for, 59Scrubby Zoom, 40, 59with shortcut keys, 39
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